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Trademarks 
SAP and Fiori are the registered trademarks of SAP SE. Microsoft Excel is the 

registered trademark of Microsoft Corporation. All other trademarks are 

the property of their respective owners. 

 

Copyright 
1999-2024 insightsoftware, LLC. No part of this User Guide may be 

reproduced in any form or by any means without the prior written 

permission of insightsoftware, LLC. 

 

 

 

 

 
Notice 
This User Guide, as well as the software described in it, is furnished under 

license and may only be used or copied in accordance with the terms of 

such license. Before using this software or reading this user guide, make 

sure you have read, understood, and agreed to the End User License 

Agreement signed by your management. 

 

SAP Requirements 
• SAP System version ECC 6.0 EHP0 or newer. 

• All GLSU installations are Unicode compliant. 

• Transport install package. 

• User authorizations for transactions FB01, FBV1, FBS1, FBB1 (as 

needed) and others as listed in Section 3 of the Technical  

Installation (at end of this manual). 
 

Minimum PC Requirements 
• Windows 8, 8.1, 10 or 11 (32 or 64-bit) OS. 

• Microsoft Excel 2013, 2016, or 2019 (32 or 64-bit) [includes Office 

365 (desktop versions only) and as specified by current Product 

Compatibility Matrix]. 

• SAP GUI (Currently supported version from SAP and as specified 

by current Product Compatibility Matrix). 

• If using Fiori and do not want to install full SAP GUI, still requires 

“Unicode RFC Libraries” and Login system configuration. 

• Hardware as required by Windows OS version. 

• GLSU supports double-byte character sets (East Asian 

Languages). 

• GLSU supports the use of SSO via SAP SNC (Secure Network 

Communication). If SNC is properly installed on the desktop, no 

additional setup steps are required in GLSU. 

• PC Application must be installed as an Administrator. 
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Introduction 

 

Have you ever wished for an easier way to get financial data into your SAP system? Chances are, 

your organization uses many homegrown applications and/or spreadsheets to pre-process your 

data before entry into SAP. This may require many hours of unproductive data-entry time by your 

processing departments or IT organization. 

 

Maybe you are already using a simple batch input loader but wish you had the flexibility to handle 

numerous requirements from different departments in your organization. Maybe you wish that you 

could do batch input with fewer errors in a timelier manner. 

 

GLSU allows an organization to streamline its financial data entry functions. GLSU provides a flexible 

and intuitive spreadsheet interface for collecting and posting transactions to SAP. From simple 

recurring general journal entries to allocations thousands of lines long, GLSU solves many common 

SAP data entry problems. 

 

Post directly to SAP without leaving Excel! 
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What is GLSU? 

Far more than a simple batch load program, GLSU uses a combination of configurable spreadsheet 

interface with a custom ABAP load program. These two items work together to deliver deep 

functionality such as... 

 

1. Configurable work space. Enter only relevant SAP data items for your specific application. 

Customize the order of fields. All spreadsheet customization is done through dialog boxes 

which let you choose and order fields from a pick list. Adding, changing, or deleting fields 

takes seconds. 

 

2. Build data-entry applications. Form input, monthly close packages, complex allocations, 

rebates, accruals, etc., can all be automated using GLSU. Different spreadsheet "templates" 

can be created, stored on the SAP server, and distributed to your workforce quickly. 

 

3. Pre-verification of data BEFORE posting. GLSU can check your input data against SAP master 

data to warn of potential errors before posting occurs. 

 

 

About your User Guide 

This guide will help you learn how to use GLSU. It will also serve as a reference as you attempt more 

sophisticated techniques. The first chapter describes the high-level concepts about how GLSU works. 

The second and third chapters explain the detailed functionality of the GLSU spreadsheet and the 

SAP portions of the product respectively. 

 

This guide assumes you are already familiar with basic Windows, and Microsoft Excel concepts – 

menus, dialogs, mouse operations, such as clicking and dragging. This guide also assumes you are 

familiar with basic SAP concepts – posting, parking, batch sessions, etc. If you need more 

information on these subjects, please refer to the appropriate Microsoft manuals or your SAP 

documentation or administrator. 
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How Does GLSU Work? 

 

GLSU is a spreadsheet uploader tool that runs in a two or three-step process. It has both ABAP and a 

Visual Basic Add-in which work together to provide a complete solution. GLSU can post data to your 

SAP system in two ways: 

 

1. Direct Posting 

2. Batch 

 

Direct Posting allows you to enter SAP data without ever leaving the spreadsheet. Excel dialog 

boxes tell you if the posting was successful and return the SAP document number and other SAP 

messages upon a successful post. 

 

At the highest level, the GLSU batch posting functionality works in a two-step process... 

1. User inputs data into the spreadsheet. This is the posting data which will then be posted to 

SAP. These entries can be as long as you require. You are not limited by any SAP limitations 

on document posting size and you can post multiple worksheets at a time. 

2. Post the export file to SAP. Using the GLSU custom transaction "ZGLSU", the user will then post 

the data to SAP using a simple procedure. 

 

Installing GLSU the first time is a simple process and is explained in detail in the next chapter Getting 

Started. Installing GLSU involves activating the GLSU add-in in Excel. 

 

The GLSU spreadsheet functionality is provided by an Excel "Add-in". This add-in is written using 

Microsoft Visual Basic for Applications. 

 

Once activated, the Add-in will provide additional GLSU functionality. The functionality is accessed 

by new items in the Excel Ribbon. These menu options are explained in detail later in the manual. 

 

  

 

 

 

 

 
GLSU is written using Excel 

macros. There is no risk of 

having virus issues when 

installing and running GLSU 

code via the add-in. 

 

All Z Option add-ins are 

digitally signed to ensure 

your protection. 
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GLSU Ribbon Menu Features 
 

Once activated, GLSU has its own tab in Excel with specific features in a Ribbon menu format. 
 

 

 

 

 

 

 

 

 

 

 

 

1.   Processing 
 

 

POST / PARK 

This feature will first Validate the sheet(s) [depending on settings], and then Post 

or Park the document(s) in SAP. 
 

 

 

EXPORT 

This feature will Validate the GLSU sheet(s) [depending on settings], and Export 

the data to a single .ZGL file (for processing manually using SAP transaction 

ZGLSU). Also see section Export a Document (2-Step Posting Process). 
 

 

VALIDATE 

Validates the GLSU sheet(s) and displays a list of errors that need to be repaired 

before an Export or a Post/Park can be done. See more on Validating here. 
 

 

 

REVIEW VALIDATION 

This window brings back the list of validation errors showing the issues and the 

location of each. 

2.  Tools 
 

 

OPTIONS 

Allows for SAP system connection setup, sheet selection for processing, and a list 

of general options and settings. 
 

 

CHOOSE FIELDS 

Allows the user to select which SAP fields are on the current GLSU sheet.  Used to 

add/remove the fields from the sheet. 
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REFRESH DESCRIPTIONS 

Refreshes descriptions by connecting to SAP and updating all cells that contain 

the "=glsu_description(xx)" formula (where xx equals the cell where master 

data element is entered) 

 

 

 

 
IMPORT 

Allows for importing of delimited data directly into a GLSU sheet. Mapping of 

incoming file fields to GLSU fields is supported. Also see section Importing Data. 

3.  Utilities 
 

 

LOGOUT 

Disconnects the GLSU connection to SAP. 

 

 

INITIALIZE 

Creates a new GLSU sheet.  This will bring up the CHOOSE FIELDS dialog so that 

the GLSU fields can be selected or the defaults taken. 
 

 
 

RESET LINKS 

Reads the GLSU sheet to find and fix any broken GLSU formula links such as 

"=glsu_description()" and "=glsu_balance()". If the location of the add-in 

changes, Reset Links will point formulas to the correct location of the add-in. 
 

 

SHOW MY CONTACTS 

Displays the contact information all of your GLSU Premium Users. Premium users 

often can solve accounting questions. 
 

 

RETRIEVE VALIDATION DATA 

Connects to SAP to update validation preferences, and if Validation Options are 

set to .INI, will then retrieve the data to the .INI file. 
 

 

SHOW VALIDATION INFO 

Show a list of validation fields and whether the data set is LOCAL or LIVE. 
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EXPORT DEFAULT LANGUAGE 

Exports the internal default English language strings to a file.  A translator may 

then edit this file to localize the language. 
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4.   Help 
 

 
 

 

 

GLSU VERSION INFO 

This "About" dialog shows the component version information necessary for GLSU 

support questions. Clicking on the “More…” button will give detailed information 

that is useful for support as well. If you would like to attach this information to a 

support ticket, click on the “Save as…” button 

 

 

 

GLSU MANUAL 

This feature will link you directly to the latest manual online for the GLSU version 

that is installed. 
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Customize Your Spreadsheets 
 

Each column in the GLSU spreadsheet represents an SAP data element for posting. There are 

columns for each header and detail field which could be populated. GLSU allows you to customize 

which SAP data elements are available on your spreadsheet. Each user or department can use 

GLSU in a way that is intuitive for them. 

 

Adding, changing, or deleting fields on the spreadsheet (even PA characteristics) is configurable 

and does not require re-coding of the spreadsheet or the ABAP load program. 
 

Example: Accountants may not care to validate against 

customers, and the Receivables department may not care 

about Vendor master data. 
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Customize by Department 
 

Each of your departments may have a set of fields which are unique to them but are rarely used by 

other groups (vendors for Payables, customers for Receivables, etc.). GLSU lets you tailor the 

spreadsheet for the needs of these individual departments. 

 

These customized spreadsheets can then be stored centrally on your SAP server as Templates. 

Central storage of these templates enables... 

 

Consistency. By having your processing personnel download these centrally stored Templates, 

you can ensure that your data is being entered in a consistent fashion. 

 

Ease of distribution. Central storage of the templates also facilitates the enterprise-wide 

distribution of these templates. Everyone that has access to SAP can download the templates. 

(NOTE: GLSU Templates may also be distributed as Excel (.XLS) files via other methods such as 

email, FTP, etc.). 
 

Department 1 Department 2 

Account, Customer, Terms, Amount Account, Vendor, Amount 

3 Fields 4 Fields 
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Validate Data before Posting 

 

GLSU lets each user choose SAP master data fields to pre-validate before posting. Company Codes, 

Posting Keys, Cost Centers, Profit Centers, Customers, Vendors, Field Status Group information, and 

many others are all selectable. 

 

This feature ensures that your user’s data-entry is correct before posting to SAP. This will reduce error- 

correction time and increase productivity. 

 

 



  page 19 

 

 

 

Definition of Users 

 

There are three types of GLSU users: Premium users, Standard users, and all other employees or 

business partners of the customer. These three types of users have different capabilities with GLSU. 

 

 

 

 Licensed GLSU Users  

 

Function 

 

Premium 

 

Standard 
Everyone 

Else 

 
Posting Functionality 

 

Install GLSU Add-in ✓ Yes ✓ Yes ✓ Yes 

Use the GLSU spreadsheet ✓ Yes ✓ Yes ✓ Yes 

Perform Live Validations ✓ Yes ✓ Yes No 

Post the spreadsheet to SAP (requires SAP authorization) ✓ Yes ✓ Yes No 

 
Template / Spreadsheet Control Functionality 

 

Customize GLSU spreadsheets ✓ Yes ✓ Yes ✓ Yes 

Download spreadsheet templates from SAP to PC 

(SAP access required) 
✓ Yes ✓ Yes ✓ Yes 

Manage GLSU templates stored on SAP ✓ Yes No No 

 
Help / Support 

 

Telephone / case/ticket support ✓ Yes No No 
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What’s New in GLSU? 

 

We are committed to aggressive ongoing development of GLSU.  
NOTE: Naming nomenclature has changed to the insightsoftware standard (YY.Q) after version 8.5. 

 

New features in GLSU version 24.1… 

 

1. Fiori readiness 

 

New features in GLSU version 23.4… 

 

1. Support for withholding tax entries for vendor/customer accounts 

 

New features in GLSU version 23.3… 

 

1 .  Duplicate Entry Consolidation 

 

New features in GLSU version 23.2… 

 

2 .  Pre-Validation cache, improved validation times by up to 50% 

3 .  Master data description improvements – change descriptions 

language from the same worksheet 

 

New features in GLSU version 23.1… 

 

1.   Closing Metrics Report/Dashboard 
 

New features in GLSU version 8.5… 

 

1.   EWF (Easy Workflow) integration ( requires purchase of Easy Workflow solution ). 
 

New features in GLSU version 8.0… 

 

1.   Validation Markers with Conditional Formatting of all pre-validations 
 

New features in GLSU version 7.0… 

 
1. Create a template from Parked Documents. 

2. Enhanced Journal Entry Template display/entry options 

3. Enhanced Document History Logging (record parked documents) 

4. Enhanced Support for SharePoint/OneDrive environments 

 
New features in GLSU version 6.2… 

1. Support added to post Recurring Entries (FBD1 type entries). 

2. Support added for Recurring Entry Pre-Validations. 

3. Multiple attachments with support for any file type. 

4. Auto-plug rounding tolerance. 
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5. Displays detailed component information in “GLSU Version Info” for GLSU and SAP GUI 

environment (troubleshooting enhancement). 

 
New features in GLSU version 6.0… 

1. Park Documents to Non-Leading Ledgers. 

2. Support for 64-bit MS Office installations. 

3. Download templates from GLSU directly as an initialization option. 

4. Copy existing posted documents as an initialization option. 

5. Select individual sheets for export, validation, and post/park actions. 

6. The Ribbon menu will now read "Post" or "Park", depending which transaction is selected. 

7. The local validation data is automatically updated on the first login. 
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8. Import data from delimited files directly into a GLSU template. This includes the ability to 

create offsetting entries automatically if the data is available on the incoming records. 

9. Custom pick list support is available for custom fields. ABAP function module coding is 

required. Working examples are provided. 

10. Automatically add a description field to a template for an existing field. 

11. Document attachment size can now be controlled by a Premium user. The worksheet size is 

viewable in GLSU along with a breakdown of individual sheet sizes. 

12. Allow Premium user to globally control access to transactions and the "Choose Fields" menu 

option for all users. 

13. Pick lists now support "pinning" favorite values so that they stay on top for ease of access. 

14. Cross-company document numbers are now returned in the BVORG field (Cross-CC No.) 

and are linked to the cross-company document. 

 

New features in GLSU version 5.0… 

1. Initialize from a SAP document enhancement – Facilitates quick creation of a GLSU 

template with data from existing SAP financial documents. 

2. Show blocking indicators in pick lists for Cost center, Profit center, and Internal orders. 

3. Add pick values for Reversal reason, fields with fixed values, and select fields with SAP check 

tables. 

4. Pre-validation of accounts which are "Post automatically only" and "Reconciliation accounts" 

and exclude from pick lists. 

5. Option to view SAP Message Long Text information in pre-validation. 

6. GLSU functions available in an Excel Ribbon menu. 

7. Premium-user controlled Default User Settings. 

 
 

New features in GLSU version 4.2… 

1. Support for Windows 8, Excel 2013. 

2. Support for Multi-Portal SSO (Single Sign-On). 

 

New features in GLSU version 4.1… 

1. Pre-validation enhancement for Cost Accounting and Financial Account line items within 

GGB0 (sister configuration transactions – OKC7 and OB28, respectively), configured coding 

block checks usually including PAI exit for customer fields in coding block, asset checks, SD 

order checks, funds management checks, CO relevant fields, FI relevant fields, MM relevant 

fields, and joint venture checks. 

2. Document number drill-back (from Excel to interactive SAP screen). 
 

New features in GLSU version 4.0… 

1. Attach source spreadsheet documents to the BDS (Business Document Service) in SAP. 

2. Show cross-company (intercompany) and split document numbers. 

3. Double-byte (East Asian Language) Unicode support. 
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4. Windows installer (mainly to aid in Citrix and other non-end-user involved deployments) 

5. GLSU SAP side installation check function.
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SOX Compliance 

 

GLSU meets basic data access requirements for SOX (Sarbanes-Oxley Act) standards. 

GLSU has always restricted access for posting documents by leveraging standard SAP authority 

objects. The additional checks which are now in place ensure that data, at a company code level, 

cannot be viewed in the off-line validation file, off-line and live pick list, or off-line and live 

description functionality unless the user has specific authority to view the data. 

For specific details on what authority objects are checked, please see Section 3 of the "Technical  

Installation" section. 
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Getting Started 

 
GLSU consists of SAP and PC components; 

both parts have to be installed for the GLSU add-in to work.  &  

✓ PC files ✓ SAP transport 

A complete GLSU installation on a PC has Your company's SAP BASIS team will install 

two (2) Excel Add-In files for GLSU 'Active' this component into your SAP system(s). 

(within Excel): 

1. "Z Option GLSU.xla" The transport only needs to be done once 

2. "Z Option GLSU Ribbon.xlam" per SAP system, but 

You should be able to see both parts in 

Excel when you go to Excel → File → 
Diagnostic steps for GLSU within SAP are 

Options → Add-Ins. 
explained in steps in the section GLSU SAP- 

Side Installation Check (Technical/Project 
Team Utility). 

Please NOTE that GLSU must be installed and the license unlocked on each SAP system to be 

used with GLSU [i.e. DEV, TST, PRD, etc.]. 

 

The license must be unlocked in SAP on each client in each system. 

 

This getting started section is broken into three sections…. 

1. Technical Installation:  This is done by your company’s BASIS team, and is the first step in the 

process. Technical installation instructions are detailed in the last section of this manual. 

2. Unlock the GLSU Licenses: This step is the second in the installation process. It takes place 

after GLSU has been installed on your development platform. License Unlock procedures are 

done by your company’s Premium User(s). This is the point where you will configure GLSU with 

the Premium and Standard Users. This must be done for each SAP client in which you want to 

use GLSU. 

3. Posting your first spreadsheet:  After GLSU has been technically installed and unlocked, you 

will want to post your first simple spreadsheet. This section will explain the steps required to do 

this by introducing you to the basics of GLSU’s functionality. The following section will explain 

GLSU’s capabilities in much greater detail. 

 

Step 1: Technical Installation 

Proceed to the last section of this manual. This section contains the sequential steps necessary to 

install the GLSU transport onto your development system. 

 

Instructions for using the GLSU Ticket System are also explained in the Technical Installation section at 

the end of the manual. 
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Once the GLSU transport has been installed, the logical file path has been configured, and 

necessary authorization profiles have been edited, then it is time to move to the next section: 

Getting Started for Premium Users… 
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Getting Started for Premium Users 

 

Premium users at your site will be responsible for maintaining the specific users who will be using 

GLSU. 

 

After the GLSU software has been properly installed on your SAP system, use transaction ZGLSU to 

start the GLSU program. Premium user functions are accessed by clicking on the "Premium User 

Functions" button. 

 

 
 

To get started, the Premium User(s) need to do the following tasks in order presented. These steps 

are explained in detail on the next few pages… 

1. Maintain the GLSU license. This step tells your copy of GLSU how many seats have been 

purchased by your company.  This must be done for each client in which you want to use 

GLSU. 

2. Maintain the Premium Users. You will need to name at least one Premium user before 

anyone can post using GLSU. This must be done for each client in which you want to use 

GLSU. 

3. Maintain the Standard Users. You can either have GLSU auto-register the standard users or 

you can name them manually. This must be done for each client in which you want to use 

GLSU. 
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Step 1: Maintaining the GLSU License (Premium Only) 

 
The first step in getting GLSU running is to setup/maintain the GLSU license. Execute transaction 

ZGLSU in SAP. Once in the GLSU transaction, type "PREM" in the SAP command box and press Enter. 

Clicking on the "Maintain License" button from the Premium User Function screen displays the dialog 

box shown in the image below. (NOTE: Depending on if any license data already exists [i.e. system 

copies], you may not need to enter the "PREM" function, the license dialog may display 

automatically.) 
 

 

The "Maintain License" screen shows the number of Premium and Standard users which have been 

licensed and how many have been used at your company. To change these numbers of licensed 

users (either the first time you use GLSU, or if you add seats later) you will need a "License Unlock 

Code". The "License Unlock Code" is supplied by insightsoftware. 

1. Open an Internet Web Browser and go to  

http://licensesupport.zoption.com/ticket2/index.php. 

2. If you have not already done so, each Premium user should request a ticket system login ID 

by selecting “Request System ID” Fill out all of the information and submit your request. 

3. Once your ticket system ID has been confirmed (you will receive an email) you may log in to 

the ticket system on the same support page by click "Login”. 

4. After you are logged in, select "License & Unlocks” 

5. Select company name, "GLSU" and "License" from the drop-downs. 

6. Copy&Paste the Registration Code FROM SAP, enter into the website field with the same 

name. 

7. Click "Request Code".  Copy&Paste the Unlock code FROM THE WEBSITE SCREEN back to the 

**SAP** entry box with the same name. 

8. Press Enter, or click the green checkmark to Save 

http://licensesupport.zoption.com/ticket2/index.php/
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Step 2: Maintaining Premium Users (Premium Only) 
 

Premium users must be individually named on your system. To set up the Premium users for your site: 

Restart the ZGLSU transaction (/nZGLSU in the SAP command box). Once in the ZGLSU transaction, 

type "PREM" in the SAP command box and press Enter. From the Premium User Function screen click 

on the "Maintain Premium Users" button. The following dialog box will display: 

 

Click the "New" icon at the bottom of the "Maintain PREMIUM Users” screen. 

 

 

 
 

 

1. To add a Premium User, you will need a Premium User Unlock Code. You will need to type in 

the new Premium User’s SAP user ID into the Username field. 

2. Login to the License system (see previous section) 

3. Select the company name, "GLSU" and "Premium User" from the drop-downs. 

4. On Maintain PREMIUM Users screen in SAP, click "Create New Entry" button (white page 

icon). On the Add User pop-up, for "Username" in SAP, enter THE SAP ID OF THE PERSON YOU 

WANT TO ADD. 

5. Copy&Paste the Registration Code FROM SAP, enter into the website field with the same 

name.  In the web form user field, enter THE SAP ID OF THE PERSON YOU WANT TO ADD. 

6. Click "Request Code".  Copy&Paste the Unlock code FROM THE WEBSITE SCREEN back to the 

**SAP** entry box with the same name. 

7. Press Enter, or click the green checkmark to Save. 

8. Repeat steps 4 – 6 as necessary for all Premium Users. 
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Step 3: Maintaining Standard Users (Premium Only) 
 

You can register your Standard users in GLSU in 2 different ways. 

1. Automatic registration. GLSU will know how many licensed users are available at your site. It 

will keep track of the different users who have LIVE VALIDATED or UPLOADED entries using 

GLSU. When the license limit is reached, no new user names will be allowed to upload entries 

until one of the two procedures below is performed to free up more seats. 

2. Manual registration. If you want specific people to upload entries using GLSU, you should 

manually add their login names to the GLSU registered users list. 

There are two ways to get more Standard Users access to upload GLSU entries. 

1. Purchase more Standard seats. A new "unlock code" will be issued which will allow more 

unique users to upload entries. 

2. Remove existing Users internally registered as Standard users so that new users can be 

registered automatically by GLSU, or registered manually by a Premium User. 

Remember that there is a difference between Standard Users and Un-Registered Users. Standard 

Users are allowed by GLSU to upload entries. Un-Registered Users can use all the GLSU functionality 

EXCEPT posting. This will allow employees at your company to download the GLSU add-in and 

download the master data. 

To maintain the Standard Users in SAP… 

1. Click the "Premium User Functions" button in the GLSU "ZGLSU" transaction. 

2. Click the "Maintain Standard Users" button. The following screen will display… 
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3. To have GLSU automatically register users, enable the "Auto-register Enabled?” checkbox. 

4. Enter the username and click the "Check" icon. 
 

 

5. To manually delete users, click the "Delete" icon. 

6. Once your changes are complete, click the "Check" icon to save your changes. 
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Step 4: Uploading new Add-ins (Premium Only) 

 

GLSU works with two sets of programming code. The ABAP code (transaction ZGLSU on SAP) controls 

the functionality of posting and user maintenance. The Visual Basic for Applications code controls  

the functionality of the spreadsheet. This Visual Basic code is stored in an Excel add-in. Typically, the 

ABAP and the Visual Basic Add-in are upgraded together. However, there may be times when a  

new Visual Basic Add-in will be released separately from the ABAP. New spreadsheet functionality 

could then be acquired without re-transporting a new version of the GLSU ABAP code. 

 

We will provide the application (in the form of a SetupGLSU.exe file) to your Premium User(s). Once 

the VB code has been received, it will need to be uploaded to your SAP server. NOTE: You MUST 

perform this upload step for each SAP system/client combination if you wish to deploy the PC 

components from SAP. The functionality to upload a new VB Add-in is under the "Premium User 

Functions" screen. Click the "Upload Add-in" button then browse to the location of the 

"SetupGLSU.exe" file on your computer. Select "Open" and then confirm the upload. 

 

Your Premium User(s) should then test the new VB code. Once satisfied, they should notify the GLSU 

users to download the new Add-in. 
 

 

You are now finished with all of the Premium-User-only steps. Please proceed to the next section, 

"Getting Started for Standard Users", to continue the setup process. 
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Getting Started for Standard Users 

 

The first step to get GLSU on your PC is to download the GLSU Add-in from the GLSU ABAP program. 

GLSU spreadsheet functionality is provided by an Excel add-in. This add-in contains the 

programming which makes GLSU work on your PC. 

 

To get started, you will need to… 

1. Set your GLSU validation choices 

2. Download/install the GLSU add-in 

3. Create your first spreadsheets 

 

 

This section will walk you through the initial steps to post your first GLSU spreadsheets. The following 

section "Other Spreadsheet Features" will detail the remaining GLSU functionality. 

 

 

Standard Users Step 1: Set your GLSU Validation Choices 

 

The GLSU ABAP program will allow you to configure the GLSU validations to your requirements. 

 

For most installations, the "LIVE" validation settings will make the most sense. This setting causes GLSU 

to use live data to validate your workbook. GLSU comes pre-configured with this setting. However, 

should you wish to view or change these settings please see section "Setting Your GLSU Validations  

Options". 
 

For those items that are not marked as "LIVE" and are pulled to the front-end for validations, there is 

a choice that can be made between manually updating this file (using the "Retrieve Validation 

Data" menu item and automatic. The Automatic setting is ON by default.  This feature will refresh 

the validation data automatically on the first login. This is controlled by a setting on the "General" 

tab of the "Options" dialog. 
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Standard Users Step 2: Download / Install the GLSU add-in 

 

If your desktop admin group has already installed the GLSU add-in, or if you are installing from a 

network location you can ignore this page of instructions and simply run the SetupGLSU.exe installer. 

 

To download and install the GLSU add-in on each PC…. 

1. Ensure that the GLSU ABAP program has been transported and properly installed on your SAP 

system. 

2. Start SAP. You must have an SAP logon to download the GLSU Add-in. 

3. Execute the GLSU transaction ZGLSU. 

4. Make sure you have set your validation options as described in the previous chapter. 

5. From the GLSU transaction, choose the "Download Add-in" button. 

6. A standard Windows dialog box will appear and ask where the installer should be 

downloaded. You can change this if desired but we recommend you do not. Click "Save". 

7. Click "Yes" to confirm the download of the installer. 

8. Click "Next". 

9. On the destination folder install step, we highly recommend installing to the default 

installation path. Click "Next" and then "Finish". 

10. Click "ok" through the add-in installer steps until the installation is complete. 

Start Microsoft Excel and note the new "GLSU" menu in the ribbon. 
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Standard Users Step 3: Create your first GLSU spreadsheet 

 

Once the GLSU Add-in has been downloaded to your PC and activated, you may now begin using 

GLSU. To proceed, you may either Initialize a new spreadsheet or download an existing template 

from the SAP server. This section explains how to set up a spreadsheet from scratch. The next section 

explains how to download a template which has been created and customized by your company’s 

Premium users. 

 

To Initialize a new spreadsheet, perform the following steps… 

1. Download and activate the GLSU Add-in. See the previous section for detailed instructions. 

2. Choose "GLSU" from the Excel Ribbon (if not already selected). 

3. Choose "Initialize". 
 

 
 

4. In the Initialize Worksheet dialog box, choose "OK". 

 

 

5. On the next dialog box, select "Initialize". NOTE: There are instructions for the "Initialize from a 

SAP Document" option later in this manual. 
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If you are installing GLSU for the first time, the "System" will say "No Systems Found". In this case you 

should click the "Add System" button, then log in to your desired SAP system so GLSU can retrieve 

vital information about that SAP system and subsequently you will be able to post to it. You can 

perform this function multiple times for multiple SAP system/client combinations you may wish to use. 
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6. Hit "OK" and the pick list will be displayed… 

 

 

7. As of GLSU 7.0, there are now two types of GLSU templates that can be created, “Standard” 

and “Vertical Header”. The standard template will be selected by default. Vertical header 

templates will be discussed later in this document. 

8. Configure your spreadsheet by choosing fields in the "Possible" boxes [labelled "Fields in SAP"] 

and moving them to the "Selected" boxes [labelled "Fields on Spreadsheet"]. This is explained in 

more detail later in the manual. Use the "Add >>" and "<< Remove" arrow buttons to edit the 

fields which are in the selected boxes on the right of the screen. 

9. Click the "Accept" button. 

10. Type your FI entry data into the spreadsheet. Header information goes at the top of your 

spreadsheet. Detail information goes in the second section of the spreadsheet. If you need fields 

which are not on your spreadsheet, re-do the steps explained above which describe how to edit 

the fields on your spreadsheet. 

11. When you have keyed in your data, you should then validate it before exporting the upload 

file… Choose "Validate". 
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12. Once your spreadsheet is validated, Post the document to SAP. 
 

 

13. You will be asked to log onto your SAP system to post. This is explained more fully in a later 

section of the manual. 

 

 

 
 

Create and Use a Vertical Header GLSU template 

 

As of GLSU 7.0, a new GLSU template format has been added: Vertical Header. 
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In prior versions of the GLSU add-in, the only option was to create a Standard GLSU template. The 

Standard template format shows the document header fields (BKPF) on two rows. In the Vertical 

GLSU template the row-type header field section is hidden and a Vertical Header data entry area is 

created. This is sometime referred to as a “Journal Entry” format. Typically GLSU users have been 

creating this vertical entry format manually. The downside to this is that when new header fields are 

added, moved, or removed, the vertical header data entry area that was manually created often 

requires additional manual changes to continue to work properly. This new feature will not only 

create a vertical header entry area for you; but it will also maintain it automatically as you make 

changes in the “Choose Fields” screen. 

 

To create a Vertical Header template format, select “Choose Fields” and proceed to select and 

arrange your fields as you normally would. When you are ready to create the template, select the 

“Vertical Header” setting. Pressing “OK” will create the vertical header formatted template. 

 

What you will see that the row-wise header data entry area is now hidden. The fields from the   

hidden BKPF header rows will now be displayed in a vertical data entry format. Note that there are 

two buttons present to allow you unhide and hide the original standard BKPF header rows for review. 

The feature will be discussed more later in this document. 

 

The vertical header consists of two columns. The first column represents the header field description 

while the second column represents the data value for the header field.  Any changes that are 

made to the header description and header value will be copied to the hidden BKPF header fields.   

If you would like to see this, make changes to a vertical header field description and enter a data 

value. Click on the “+” button to view the standard header. You will see that your changes have 

been copied to the standard header. In addition, you may make edits to the standard header’s  

field descriptions and data if you like. All changes made in the standard header will be copied up to 

the corresponding fields in the vertical header area.  Note that you may also make formatting 

changes either on the vertical or standard header areas. For example, all font, color, field   

alignment, etc.  call be changed as desired. Note, however, Excel does not see these as cell 

changes and won’t copy the formatting until a header description or field value is entered. Along 

these lines, you can set the “Auto format” setting “off” to retain all formatting in the template. This 

setting is found on the “General” tab of the “Options” screen under “Formatting”. 

 

The Vertical Header format has a few additional features that should be noted: 

• Any existing GLSU template in the standard format can be converted to a vertical format just 

by changing the setting in the “Choose fields” screen. 

• You can switch a GLSU template from standard to vertical or from vertical to standard at any 

time with no loss of data. 

• Any user data above or to the right of the vertical header rows will not be lost when you 

add, move, or move header fields in the “Choose Fields” screen. 

• When entering data into the vertical header data fields, pressing the [enter] key will move 

the selected cell to the next data entry field. Entering data and either clicking on a new cell 

or using the arrow keys will produce the same result. 

• Once you have entered data into the last vertical header field and pressed [enter], the cell 

selection will move to the first data entry cell in the line items area. 

• The vertical header area, which includes the cells in column A, cannot be moved or 

deleted. This is a protected area. If a row in the vertical header is deleted GLSU will 

automatically undo that change in order to maintain the one-to-one links to the BKPF 

header fields. 
• Mixing standard and vertical header sheets in one workbook is supported. 
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Regarding Formulas in the Vertical Header 

 

Because all data entered from the vertical header is copied to the hidden BKPF header fields, 

formulas are not permitted in the vertical header data entry fields. For example, if you have a 

“Document Header Text” field in vertical header and attempt to enter a “=glsu_description()” 

formula, GLSU will let you know that this cannot be done. If you chose to continue, GLSU will unhide 

the BKPF header and place the cell selection in the proper field. This is where you enter all header 

formulas. As the formulas create a change in the BKPF header cell, this data will be copied to the 

vertical header for you. Please also keep in mind that entering a formula anywhere on the GLSU 

template that references a cell in the vertical header area will not work as expected. As you make 

changes to the fields in the vertical header using the “Choose fields” screen, the vertical header is 

effectively removed and recreated. Therefore, any formulas in the GLSU template that are tied to a 

cell in the vertical header will also be removed by Excel. 

 

Vertical Header Templates Loaded into pre-GLSU 7.0 Versions 

 

The Vertical Header feature has been added only to the GLSU 7.0 (and future versions). This means 

that a workbook containing a vertical header formatted template will not work as expected when 

loaded into prior versions of GLSU. The workbook will load properly and all data will be preserved. 

However, you will find that changes to the vertical header fields will not copy to the BKPF header 

automatically as they do in GLSU 7.0. Further, the BKPF header area may still be hidden when the 

workbook was saved. This is not really an issue and can easily be handled. 

 

Scenario: A GLSU 7.0 user creates a vertical header template workbook. The template is then 

loaded into a machine that has GLSU 6.2 (or earlier) installed. 

 

The workbook will open without issue. The user will see the vertical header formatted area. However, 

the vertical header will not work as it does in GLSU 7.0. It will need to be removed manually. To 

remove the vertical header and use the GLSU template as a standard template, follow these steps: 

 

Option 1: 

1. Highlight the vertical header rows, including the row with the buttons showing, and delete  

the rows. If deleting the rows is going to remove user data, it would be best to manually clear 

out the vertical header area cells and then format the user data as desired. 

2. Highlight the hidden rows above the “Line Items:” section. Right-click on the selected rows 

and select “Unhide”. The “Header” rows (BKPF) should now be visible. 

3. From here, you can use the template as you would any other standard GLSU template. 

4. When you pass the template back to a GLSU 7.0 user, they have the option to convert it 

back to a vertical header format in the “Choose Fields” screen. No template data will be 

lost. 

 

Option 2: 

1. Highlight the rows that the vertical header occupies and hide them. 

2. Highlight the hidden rows above the “Line Items” section. Right-click on the selected rows 

and select “Unhide”. The “Header” rows (BKPF) should now be visible. 

3. From here, you can use the template as you would any other standard GLSU template. 

4. When you pass the template back to a GLSU 7.0 user, they have the option to convert it 

back to a vertical header format in the “Choose Fields” screen. No template data will be 

lost. 
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Note: ANY pre-GLSU 7.0 template can easily be converted from a standard format to a vertical 

format using in the “Choose Fields” screen. 

 

Technical note: The vertical header functionality makes use of Excel’s ability to detect when a cell 

value has changed. Under rare circumstances this feature of Excel may stop working. This can 

happen if an Excel system error dialog pops up. If this happens, you can still validate and post. These 

functions push a copy of the vertical header data into the BKPF fields. The validation and post will 

work as expected. However, best practice would be to simply save the workbook and then close 

and re-open Excel and the workbook to regain full functionality. 
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Other Spreadsheet Features 

 

The following pages will discuss the functionality of the GLSU spreadsheet in greater detail. 

 

 

 

Initialize New Worksheets 

 

GLSU allows you to manage multiple worksheets independently in a spreadsheet. These worksheets 

can be configured independently of each other. They may also be posted independently. 

You will also use this functionality to initialize a new spreadsheet for GLSU entry. 

To set up a new worksheet in an existing spreadsheet... 

1. Choose Initialize. 
 

 

2. In the message box Initialize Worksheet?  Choose "OK". 

3. You can choose from 1 of 3 options. The first will create a new GLSU template with no data, only 

blank fields you select. The second loads a stored GLSU template, blank without data. The third 

option allows you to retrieve data from an existing SAP Financial document. 
 

 

4. In the GLSU Options dialog box, choose a single worksheet, a range, or a select list of sheets. This 

will initialize the spreadsheet but not format it/them. 

5. (OPTIONAL): If you chose "Initialize from a SAP Document", you will see the following: 
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Enter an existing SAP document number, Company Code, and Fiscal Year for any posted 

(FB01) or parked (FBV1) and select "OK". 

Note 1: Only fields selected in the ZGLSU transaction will be populated with data. i.e. if field 

SGTXT (Line Item Text) has text in the SAP document but field SGTXT is NOT in the GLSU 

template (or has been suppressed by one of your Premium users) GLSU will ignore the values 

in SAP. Premium users may want to configure SAP to always ignore certain fields to streamline 

this process for end users based on your specific SAP configuration. This can be configured  

by Premium users in the Default and Hidden Field List. 

Note 2: The “Initialize from a SAP document” feature is not meant to load some FI 

documents. In some cases, it will not create a post-ready document because of other SAP 

functionality, including but not limited to substitutions, custom enhancements, derived 

values, etc. 

6. The pick list will then display. Configure your spreadsheet. It will configure all worksheets in your 

spreadsheets if you have chosen to initialize more than one. 

7. Click the "Accept" button. This will then format all worksheets you have selected. 
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Add/Delete Columns 

 

GLSU allows complete control over which fields are available to the user. Any field which is available 

in your FI configuration may also be posted to via GLSU. As your company’s configuration changes, 

GLSU automatically updates the Possible Fields listing so that you always have access to the relevant 

SAP fields. 

 

Use the arrow buttons to move fields, or you can also drag and drop the desired fields. 

 

 
 

From the GLSU menu… 

1. Click on menu item "Choose Fields" from the GLSU Ribbon. 

2. The pick list is organized into Header Fields and Detail Fields. 

3. The pick list is also organized into possible and selected fields. 

4. Select fields (use arrow buttons or drag-and-drop) and re-order them (graphical buttons 

only) as desired. 

5. The “Standard” template is selected by default. If you would like to a “Vertical Header” 

template, select the Vertical Header setting. Note: The “Vertical Header” template style was 

added in GLSU.70 and explained later in this document. 
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6. Click the "Accept" button when satisfied. 
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You can search for specific technical field names and field descriptions by entering your search 

string into the Search box and then press "Search". Both the possible header and detail fields are 

searched. "Reset" will return all possible fields to the list. 

 

If your Premium user has configured hidden fields, you will not see these fields as a default. This is 

meant to reduce clutter or remove fields which are rarely or never used. However, these fields are 

still available simply by checking the "Show Hidden Fields" checkbox. 

 

If your Premium user has configured default fields, these fields will automatically appear in the 

selected fields, although they can be removed if desired. 

 

Re-Order Columns 

Once you have chosen the appropriate fields for posting, you can order these fields in whatever 

order makes sense for your application by using the spinner arrows on the right-hand side. 

 

 
 

From the GLSU menu... 

1. Choose menu item "Choose Fields". 

2. In the "Selected Fields" column, choose the field you want to move. 

3. Use the up and down arrow buttons on the right side of the screen to change their order. 

4. Header and Detail fields work separately. 
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5. Click the "Accept" button when finished. 



  page 52 

 

 

 

Post a Document 

 

GLSU gives you two ways to update your SAP system, either via a direct posting, or by a batch 

upload process. 

 

From the GLSU menu… 

1. Choose menu item "Post". 

2. On the SAP Logon screen, choose the appropriate SAP system and select "OK". 

3. On the SAP Logon at SAP screen, enter your SAP user ID and password for this SAP system, 

and click "OK". 

4. After a short pause, the GLSU system will return a dialog box with the document number (if 

the posting was successful) and any relevant warnings and error messages. 

 

 

GLSU will prompt you to log into your SAP system the first time you connect for the day (or session). 

Subsequent postings to SAP will not require that you re-log into SAP. 

To log out of a GLSU – SAP connection choose "Logout." 
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Displaying Posted Document Numbers & Messages 

 

GLSU will return posted SAP document numbers to the spreadsheet in a popup. You can also have 

the document numbers returned to a special cell in the spreadsheet. 

 

From the GLSU menu… 

1. Choose menu item "Choose Fields". 

2. Select field "BELNR" (Document Number). 

3. Select "Accept". 

 

Upon a successful posting, all document numbers posted will be displayed in this cell when it is 

available in the worksheet. 

 

If documents are posted, all of the document numbers will be displayed in this field with their 

corresponding company codes first. 

 

 
 

In addition to displaying the document numbers, GLSU can also display all of the posting messages 

from SAP. 

 

From the GLSU menu… 

1. Choose menu item "Choose Fields" 

2. Select field "ZOPMSGS" 

3. Select "Accept" 
 

 
 

Intercompany documents will not be populated in this field as only messages which are displayed in 

the SAP session are shown here. Since SAP does not show cross-company documents in this log, 

neither does GLSU. 

 

Both of these special fields can be dropped using GLSU dropped header functionality. When the 

fields are dropped the document numbers and posting messages will be populated in their 

respective positions for each new dropped header document that is created. 
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Document Number Drill-Back 

 

GLSU is delivered with the capability, if the document number field (BELNR) is present on the sheet 

and populated with an SAP document number, to drill-back to the document in an interactive SAP 

GUI session. 

 

The document number (and in the case of intercompany entries the corresponding company   

code) will be displayed in the document number field as an Excel hyperlink. You can simply click the 

link of the document you wish to view and you will be taken to an SAP document overview screen 

(FB03). You must already be logged into SAP in the appropriate system via the SAP GUI. A non-used 

SAP GUI session, or a newly created session, or an existing document display session will be used by 

GLSU. 

 

 
 

Technical notes:  Two pieces of functionality must be enabled for this feature of GLSU. 1) SAP GUI 
scripting must be "on" in the SAP GUI for each desktop. To enable this functionality, from the SAP GUI 
menu select Customize Local Layout → Options. Select the "Scripting" tab and then select the 

"Enable Scripting" checkbox. You will need to close all SAP GUI sessions before the setting will take 
effect. 2) Your technical SAP team will need to configure SAP system profile parameter 

"sapgui/user_scripting" to "TRUE". 

 

 

Posting or Parking Documents 

 

SAP financial transactions can be processed in different ways. SAP users sometimes choose to "Park" 

documents instead of immediately posting them. GLSU allows you to park your documents if you 

choose. These parked documents can then be released and posted later via the standard SAP 

process. 
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From the GLSU menu... 

1. Choose the "Options" menu 

item. 

2. Choose the "Workbook" tab. 

3. Choose the appropriate 

transaction type from the 

dropdown box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

If your requirement is to park to a non-leading ledger, you may add field "LDGRP – Ledger Group" to 

the header of your GLSU template and populate it with the appropriate ledger group value. 
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Posting Recurring Entry Documents 

New in GLSU 6.2 is the ability to create FBD1 Recurring GL Entries. This process is exactly the same as 

for posting GL documents from GLSU as described with a few additional header fields like Start Date, 

End Date, Schedule, etc. 

 

Note: Premium users have access to this feature, always. Standard users will only have access to this 

feature if a Premium user allows it. 

 

Initialize a new GLSU worksheet as described for “Post Document”.  While in the GLSU Options screen, 

select the “Post Recurring Entry”. If you don’t have this option, click “Retrieve Validation Data”.  If 

this option still is not available then please contact a Premium User. 

 

Note that all of the additional header fields can be found under Choose Fields by looking or 

searching for the “Recur” field prefix. The pick list functionality works just the same for these fields as 

any other. 

 

Here is an example of what a Recurring Entry document might look like. 
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Triggering SAP Workflow 

If standard SAP Workflow is configured, it can be triggered by Parking your GLSU entry with the 

"Document Complete" flag: 

 

1. Simply go to the GLSU Choose Fields screen and add the XPRFG - Doc.complete field to the 

header. 
 

 

2. When the field has been added to the template, then populate the new header field with 

an 'X'. 
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When this document is parked, this indicator will trigger SAP Workflow. 
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Accrual/Deferral – Booking Reversing Documents 

 

On SAP systems 4.6x and newer, GLSU will allow you to book accrual/deferral documents as well as 

normal postings and parked documents. This is equivalent to transaction FBS1 in SAP. You will need 

to tell GLSU explicitly that you want to book an accrual document as follows… 

1. Choose the "Options" menu item. 

2. Choose the "Workbook Tab" 

3. Choose the Accrual/Deferral option in the Transaction Type drop-down box. 

 
You will also have to add two new header fields to your spreadsheet. These fields are only 

allowed with accrual/deferral spreadsheets. Populating these fields in a normal posting 

spreadsheet will result in a posting error. 
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4. Field STODT – Reversal Date Field 

5. STGRD – Reversal Reason 

 

 

Foreign Currency Adjustments 

 

On SAP systems 4.6x and newer, GLSU will allow you to book Foreign Currency Adjustments 

documents as well as normal postings and parked documents. This is equivalent to transaction FBB1 

in SAP. You will need to tell GLSU explicitly that you want to book a Foreign Currency Adjustment 

document by… 

 

1. Choose the "Options" menu item 

2. Choose the "Workbook Tab" 

3. Choose the "Post Foreign Currency" 

option in the Transaction Type drop-down 

box. 

4. When choosing fields for your template, 

add any additional amount fields such as 

DMBTR (Local Currency) and/or DMBE2 

(Local Currency 2) and/or DMBE3 (Local 

Currency 3). 
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Master Data Value Lookups 

GLSU allows you to look up certain master data elements inside the spreadsheet. This functionality 

works similarly to the way search-helps work inside SAP. To see the lists of master data values…. 

1. Put your Excel cursor on a field 

2. Press F4 (or your pick list hotkey as set up in the Options → General tab. 

3. Choose the appropriate master data value. 

 

 
 

Any of the columns in the "Choose a value" dialog box may be sorted by clicking on the column 

header. Subsequent clicks on the header row will sort the fields in ascending or descending order. 

 

NOTE:  If you choose a field that you do not have configured for pick values, then the "Choose a 

value" dialog will not appear. 

 

For all date fields, a calendar will be displayed to choose an appropriate date. GLSU handles date 

formatting differences between Excel and SAP, as long as Excel recognizes the cell as a date. 
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Pick values are available for many CO-PA fields (these are fields which start with "RKE"); however, 

descriptions and validations are not available for these fields. 

 

Another way to look up the SAP master data values is by using the F4 key on your keyboard. Since 

many of our customers already use the F4 key for other functionality, the Options menu allows end- 

users to change the default F4 key to some other unused function key. See below … 

 

1. Choose the "Options" menu item from the spreadsheet. 

2. Choose the "General" tab. 

3. Find the “Select a Hotkey for GLSU Pick List Activation” section. 

4. Select a new pick list function key from the pull-down list. 

5. Check the ALT box if you want to enable, for example, ALT-F4 as your pick list hotkey. 
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NOTE: The right-click “Pick from drop-down list…” functionality has been replaced by the enhanced 

pick-list hotkey option. 

 

 

Pinning Frequently Used Values 

Once a pick list is on the screen note that the first column has the image of a pin ( ) in the header. 

This first column is special in that it allows the user to "pin" frequently used values. This makes finding 

those often used posting keys or accounts very fast and easy. To "pin" or "unpin" a pick-value simply 

double-click in the pin column just in front of the desired data value. 
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Pins are stored from session 

to session. They are stored by 

Company Code. This means 

that a list of pins stored  

under Company Code 2000 

can be different from those 

stored under Company 

Code 3000. 
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Validate Before Post/Export Option 

 

The user will probably want to validate the spreadsheet values each time before posting to SAP. 

 

1. With your spreadsheet open, 

choose the "Options" button from 

the GLSU ribbon menu. 

 

 

2. Choose the "Workbook" tab. 

 
3. Select the "Validate Before 

Post/Export?" checkbox. 

 

 

4. De-select the checkbox if you do 

not want GLSU to go through the 

step of validating your data 

against its master data each time 

you create a .ZGL file. 

 
5. This option works the same using 

the Post or Export routine. 

Each time you either directly post 

the spreadsheet or export the 

.ZGL file, the validation routine will 

be executed. 
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Check File Upload History 
 

GLSU helps prevent posting a file twice by allowing you to check the SAP system prior to posting so 

you can make sure you haven’t previously uploaded the same file. It does this check based on the 

filename of your spreadsheet. 

 
1. Choose the "Options" menu item from the 

spreadsheet 

2. If the "Check File Upload History?" checkbox is ticked, 

uploaded under your username, you will receive a 

message box similar to the one below. 
 

 

3. You will need to rename and save your file and post 

again. 
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Auto-Resize Columns 

 

GLSU has a feature that re-sizes the spreadsheet column widths each time you adjust the 

spreadsheet using the "Choose Fields" pick list. This feature was added so that fields of various widths 

are always presented properly on the spreadsheet. 

 

This feature may be overridden at the user's option. Example: If you have custom-formatted your 

spreadsheet so that it represents a form, you would probably want to turn this feature off. 

From the GLSU menu... 

1. Choose the "Options" menu item from the spreadsheet. 

2. Choose the "Workbook" tab. 

3. De-select the "Auto Resize Columns?" checkbox. 

 

 

Auto-Format Colors 

 

GLSU will automatically format the colors and appearance of the spreadsheet each time the 

"Choose Fields" pick list is activated. 

 

However, the user may be using GLSU to emulate a specific form for data entry and may not desire 

to have the spreadsheet reformatted each time a change is made to the columns. The reformatting 

setting can be disabled at the user's option. 

 

Turn this feature off if you prefer not to use the gray, blue, white, and green color scheme of the 

standard templates. 

1. Choose "Options". 

2. Choose the "Workbook" tab. 

3. De-select the "Auto Format?" checkbox. 

 

 

Ignore Columns 

 

You may choose to have columns in your spreadsheet which you do not want to post to SAP. For 

example, you may need a column for calculations which then feed the amount columns in your 

spreadsheet. Non-postable or blank columns may be added to your spreadsheet which GLSU will 

ignore when creating the uploadable .ZGL file. 

 

 

 

Additional “blank” columns are 

 

To add additional columns from the GLSU menu... 
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1. Choose menu item "Choose Fields". 

2. Select item "<<blank>>" in the pick list. 

3. Add as many of these blank columns as are required by your application. 

4. Accept the changes. 

 

 

To 

 

 
 

 

 

 

Use blank columns to store 

Excel formulas for 

calculations. 

 

You can use the blank 

columns to hold data used 

for the metrics needed for 

allocations. 
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Description Columns 

 

Blank columns are great for adding in your own notes and formulas but there is a special purpose 

"blank" column that you can use to automatically add descriptions to existing columns. Let’s use 

"Posting Key" as an example. A "Posting Key" is just another number in the spreadsheet. Wouldn’t it 

be nice to have a description next to it for clarity and for double-checking your selection? 

 

An added "<<descr>>" field is also known as a Description Column. Description Columns work best 

when the data set to be described is already entered. For our example we will use a GLSU template 

that has 8 line items already entered. Note that description fields are available for Header fields as 

well. To create a Description Column, do the following: 

 

From the GLSU menu... 

1. Choose menu item "Choose fields". 

2. Select item "<<descr>>" under either Header or Items and move it over to the right. You may 

drag it over if you prefer. 
 

 

3. When you push or drag a "<<descr>>" field over you will be shown a "Format Description 

Field" pick list. This list is meant for selecting (by double-clicking) the existing GLSU template 

field that you would like described. 
 

 

4. You can add as many description fields as you need and drag them wherever you need 

them while still in the "Choose Fields" screen. 

5. Pressing "ACCEPT" will close the "Choose Fields" screen and insert the "<<descr>>" fields that 

you have created. 
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6. Note that the Description Column is populated with the requested information. For those 

descriptions that come up as "refresh required", this means that the master data is missing 

these values. To resolve this, find and click menu item "Refresh Descriptions". 
 

 

7. Note how all of the rows that have data (Posting key in our example) are given a description. 

8. Click on a description cell to see the underlying "=glsu_description()" function. While this 

function could have been added manually, the "<<descr>>" description field adds some 

automation to this process. 

9. From here on out, if you add more line items, you will need to copy the 

"=glsu_description()" function down to each line entered in order to see the description. 

 

NOTE: Even though the "Choose Fields" selection list shows the column type as "<<descr>>", what is 

really going on is that GLSU is adding a "<<blank>>" column and automatically filling it with the 

"=glsu_description()" formula. Don’t get confused if subsequent visits to the "Choose Fields" 

screen show "<<blank>>" for the description field. This is correct. 
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Ignore Rows 

 

You may also need to have rows in your spreadsheet which do not post line items in your document. 

 

These rows could be sub-totals or other items which are used for integrity checks of the document 

before posting. 

 

 

1. In the first column of the spreadsheet, type the words "IGNORE", "COMMENT", or "SKIP". (Note 

for customers using a default language other than English: These values will be in the native 

language you have installed and translated.) 

2. GLSU will then ignore these rows when creating the .ZGL file. 

3. All other rows with data are posted normally. 

 

You can often use native Excel functionality to calculate when a row should be skipped. For 

example, if the dollar/monetary value of a calculated amount is 0 in column A of your spreadsheet, 

you could use the formula: =IF(D8=0, "Skip", " "). This could then be copied to all subsequent 

rows to avoid 0 currency warnings at the time of posting. 

 

 

 

 

 

 

Use blank rows to hold 

subtotals. 

 

This is especially useful for 

custom form development. 
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Multiple Worksheets 
 

GLSU spreadsheets can have multiple worksheets. When posting, each of these worksheets will 

create a separate SAP document. 

 

When posting, you may wish to post one, all, or a range of these worksheets in your spreadsheet. 

You could use this feature to have GLSU ignore a worksheet which contains all of your calculations 

feeding the posting worksheet(s) via formulas. 

 

From the GLSU menu... 

1. Choose the "Options" menu item. 

2. Adjust worksheet options as required. You 

can choose to export a single worksheet by 

choosing option "Export Active Worksheet 

Only". Choose a range by selecting option 

"Export Range of Worksheets" and then 

typing in the range of worksheets in the two 

fields below (see screenshot above). 

3. If you wish to export a selection of specific 

sheets, choose "Process Selected Sheets" and 

then press the "SELECT" button. 

 

 
 

 

 

 

 

 

 

 

You can use multiple 

worksheets to book 

allocations across company 

codes. Use a different 

worksheet for each 

company. 
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The SKIPSHEET feature 
 

There are actually two ways to skip sheets in GLSU. You could select the individual worksheets to 

post/park using the "Multiple Worksheets" feature documented above. Alternately, you can simply 

add the keyword "skipsheet" in cell A1 on every sheet that you never want to be acted upon by the 

export, post, or park functions. Sheets marked in this way will simply be skipped over. The feature is 

great for excluding those sheets that you use for calculations, VLOOKUPS(), and other non-GLSU 

helper sheets. 

 

 

 

Multiple Documents on a Single Worksheet 

 

GLSU has the capability to post multiple documents on a single worksheet. This is achieved by the 

"dropped header" concept. In short, any number of header fields can be "dropped" (dragged and 

dropped in the Add/Delete Columns function) to the line items. 
 

Most header fields can be dragged from the upper-right box to the lower-right box as shown below. 
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Each time a dropped header field changes, a new document will be posted. It is important to note 

that any header field which changes will trigger a new document, whether it is just one dropped 

header field, or every dropped header field. If a dropped header field is left blank, it will inherit the 

last non-blank value. 

 

Four documents will be created due the change in the Reference field in this example. 
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All four documents will have the same Doc. Header Text 

 

When using dropped header functionality, the balance cell in GLSU will no longer display 

"balanced".  Since there are multiple documents on one sheet, this functionality is not feasible in the 

context of dropped headers. However, pre-validation will still be performed to ensure each 

individual document balances. 

 

If an out-of-balance situation occurs, a pre-validation message will be issued. If you then double- 

click the error, GLSU will highlight the range of amounts on the worksheet in which the out-of- 

balance condition occurs. 
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Multiple SAP Systems 

 

Many SAP users work in an environment where there are multiple productive environments of SAP or 

development/ testing environments. GLSU gives you the ability to download master data from as 

many of these environments as required. Each time you download data from a different SAP client, 

a new and unique file of master data is downloaded to your PC. These files must be refreshed 

individually. 

 
 

1. Choose the "Options" menu item from the 

spreadsheet. 

2. Choose the appropriate environment from 

the dropdown box. This listing is 

automatically updated each time 

transaction ZGLSU is run on the SAP client in 

question. 

3. To have more than one choice available in 

the spreadsheet's Systems drop-down list, 

you must run the ZGLSU transaction in more 

than one SAP client. 

Example:  To have both production and 

testing environment information, you must 

run the ZGLSU transaction on both the 

productive and testing boxes. This then 

downloads two unique files containing 

master data to your PC. 

 

 

In order to help distinguish between workbooks for different SAP systems, you may use the SAP 

system and client formula to display this information on the worksheet. Simply add the formula 

=glsu_sysid() to any cell. If you change systems in the Options of GLSU the system and client will 

change automatically. NOTE: It may be necessary to add a skip row to avoid a pre-validation error 

when adding this formula. 

 

 

 

The SAP system choice 

does not take effect until 

GLSU is logged on to the 

appropriate SAP system. 

 

GLSU stores each unique 

SAP system and client’s 

data in a separate .INI on 

your system. 
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Pre-Validations 
 

GLSU gives the user the ability to pre-validate many of the values being keyed as well as other key 

configuration components such as blocked indicators, posting rules, and many other conditions and 

constraints to ensure they are correct before they are posted to SAP. 

 

If errors exist in data during posting, time is often wasted in trying to correct these errors. 

 

GLSU lets the user choose the fields to validate against in SAP. The SAP components of GLSU then 

download these values to the PC, either in an off-line or real-time method depending upon 

configuration of GLSU.  Pre-Validation of data and SAP configuration is a large part of GLSU 

functionality. 
 

NOTE: As of GLSU 4.1, in addition to the validations seen from ZGLSU → Validation Options, pre- 

validations for GGB0 (Cost Accounting and Financial Account Line item validations ) with sister 

transactions OKC7 and OB28 respectively are now checked. In addition, all configured coding 

block checks as defined in table TRWPR usually include the following: PAI exit for customer fields in 

coding block, asset checks, SD order checks, funds management checks, CO relevant fields, FI- 

relevant fields, MM-relevant fields, and joint venture checks. These pre-validations in GLSU will drill- 

back to the error line or row in Excel. (Technical Configuration Note: OKC7 and OB28 checks will be 

performed when activation level is set to either a "1" or a "2"). 

 

The fields which are validated are chosen in the ABAP program. See the section in the next chapter 

to learn how to choose which fields to validate against. By default, in a new GLSU installation all pre- 

validations are performed (and performed "LIVE") unless otherwise configured. 

 

 

 

Validating the Spreadsheet 

 

After SAP master data values have been downloaded to your PC via the ABAP program, the GLSU 

spreadsheet can use these values to tell you if you have keyed in erroneous data before posting. 

 

The validation can be performed either off-line (against an .INI that resides on your PC), or real-time 

(against live SAP data), or a combination of both methods. 

 

 

To perform a validation... 

1. Choose "Validate". 

2. If the document does not have master data errors, you will see the No Errors Found dialog 

box. NOTE:  If you DO have errors, you fix the errors with the procedure described on the 

following section… 
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To perform a validation... 

3. Choose "Validate". 

4. If the document does not have master data errors, you will see the No Errors Found dialog 

box. NOTE:  If you DO have errors, you fix the errors with the procedure described on the 

following section… 

 

 

To correct multiple errors... 

1. Choose "Show Validation Again". 

2. This will show you the previous listing of errors which were discovered without the overhead of 

reprocessing the validations. This will shorten the length of time it takes to correct multiple 

errors on a spreadsheet. 

 

 

 
 

Show Validation Info 

 
Since validation, pick values, and descriptions can be performed either off-line (against an .INI that 

resides on your PC) or real-time (against live SAP data) or a combination of both methods, GLSU 

provides information about the current configuration of these options. 

 

If you are a standard user of GLSU, you will not be able to change these settings, this is done by a 

Premium user at your company, but you will be able to see how each of the validated items is 

configured. 
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To see the configuration of the off-line versus real-time elements perform the following… 

 

 

1. Select "Show Validation Info" 

2. If the validation info is stored 

locally on your PC you will see 

"Stored on PC" along with the 

number of entries. 

3. If the validation info is retrieved 

in a real-time fashion from SAP 

you will see "Live from SAP" 

4. For non-static entries or entries 

which have a large number of 

records, you may want to 

consider switching to live for 

better performance. For static 

entries, you can reduce SAP 

application server load by 

configuration the elements to 

be stored on the PC (.INI). 
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Correcting Errors in the Spreadsheet 

 

If the validation performed in the previous section finds an error, a dialog box will display which 

shows the errors found. The picture below shows an error involving an incorrect GL account. 

 

 
 

If multiple errors exist, they will all show in the dialog box shown above. 

To correct the problem… 

1. Select the error in question by clicking on the appropriate line. 

2. Once the item is selected, click on the "Go To Error" button at the bottom of the screen. The 

dialog box will then disappear and your cursor will be placed in the cell containing the error. 

This is especially useful for long entries. 

Custom Validation errors, if utilized, are denoted with a "CV-E" in front of the error message, 

indicating Custom Validation – Error. 

You can view extended SAP message information (long text) for all messages EXCEPT when "GLSU" 

or "CustVal" is in the "Source" column. To view the "Source" and other values select "More". 

For ease of error processing, you may also copy to the clipboard or insert a worksheet of errors from 

the Validation Errors dialog. To do this simply right-click and then select the appropriate option. 
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After insertion of an “errors” worksheet, you may use the hyperlinks (In Excel 2000 or later) at the left 

of the newly created worksheet. 
 

 

Please note that these messages are only valid until changes are made to the contents of the 

worksheet or the worksheet name is changed. 

It is also possible to print a list of errors from this worksheet. Simply use the standard File → Print 

functionality from within Excel. 

 

 

Note: If the error is an “out of balance” situation, GLSU will not know which line item is incorrect. You 

will have to find the error manually and correct it before posting. 
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Conditional Formatting of pre-validation messages within the cells. 

In addition to highlighting pre-validation errors in the dialog pop-up and the Show Validation Again 

features, GLSU contains functionality which allows the pre-validation messages to be shown in-line via 

conditional formatting within the cells. 

 

 

To enable this feature, select the “Options” ribbon button, and then the “Validation” tab. Check the 

“Show Validation Markers” checkbox and press “ok”. 

 

 

When performing a “Validate”, the regular GLSU pre-validations will run.  If the “Show Validation 

Markers” are enabled and you have errors, your sheet will look similar to the worksheet below. You will 

need to single-click on the highlighted cell (and other cells) to view the error. 

 
 

 
 
 

You can clear the validation makers by selecting the “Clear Validation Markers” checkbox 

below the “ok” button on any validation screen and then press “ok.” 

 

Note: Please note that validation markers will automatically be cleared upon modification of 

the GLSU sheet via “Choose Fields” and upon exit from Excel.  It should also be noted that 

certain manual manipulation of the worksheet may invalidate the conditional formatting.  You 

should always be using “Choose Fields” to modify the layout of a GLSU worksheet as has always 

been the case.  In the event of a modified sheet utilizing “Choose Fields”, simply run the 

Validation again and new markers will be shown. 
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Duplicate Entry Consolidation 
 
 
GLSU can be configured to consolidate duplicate spreadsheet records for simplicity, faster processing, 

and reduction of document size.  To configure this option, select the “Options” ribbon button, go to the 

“Consolidation” tab and confirm the option is checked. 

 

A manual “Validate” action will cause the consolidation to occur if the option is active and valid 

duplicates are found.  Please note a “Validate Before Post/Export” option under “General” in “Options” 

will NOT cause consolidation to occur.  GLSU will create a new sheet with the consolidated data.  

Dropped header fields will still inherit their up-spreadsheet values (a blank dropped header field will be 

summarized with the last populated value in the sheet for consolidation purposes).  Blank fields in the line 

items will be treated as a separate, distinct, and unique value and given their own consolidated line item.  

All currency/quantity fields are summed together. 

 

The newly created sheet is in the GLSU format and may be used for posting/parking. 

 

 

Below is a consolidation example:   

 

Source -  

 

Doc.Header 
Text Posting key Account Amount Text 

doc1 40 100000 100  

 40 100000 100  

 40 100000 100 group1 

 40 100000 100 group1 

 50 100000 400  
doc2 40 100000 200 group2 

 40 100000 100  

 40 100000 100  

 40 100000 100 group2 

 50 100000 500  
 

Result after consolidation -  

 

Doc.Header 
Text Posting key Account Amount Text 

doc1 40 100000 200  

 40 100000 200 group1 

 50 100000 400  
doc2 40 100000 300 group2 

 40 100000 200  

 50 100000 500  
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Retrieve Validation Data 

 

GLSU will allow you to retrieve the SAP master data you have chosen to validate against either as an 

off-line process, or real-time (live) basis. To download the SAP master data into your PC .INI file… 

 

NOTE: The system will automatically refresh your master data each time you log in to SAP. If you 

make changes in SAP during your session it is best to click on "LOGOUT" and let GLSU refresh the 

master data again on the next login. 

 

From the GLSU menu… 
 

Choose the "Retrieve Validation Data" menu item. 

 

 

Retrieve Validation Data 

 

 
 

You will only be able to retrieve validation data via this method for datasets which are 5 megabytes 

or less. For larger off-line datasets, you should login to SAP, execute transaction ZGLSU, and select 

"Send Validation Now" or configure more live validations to reduce the PC footprint. 

 

 

The appropriate SAP master data values and texts, along with SAP fields and structures, will be 

downloaded to your PC. For most GLSU implementations you will only need to perform this function 

when you have added a new document type or legal entity (company code). 

 

 

GLSU will allow you to insert SAP master data texts into your spreadsheets for presentation or 

documentation purposes. You will put the GLSU descriptions into a blank column of your 

spreadsheet (see the "Ignoring Columns" section). Master data texts can be added in either the 

detail or header sections. 
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Adding Master Data Texts 

In the example below, Column D is a blank column. Column D contains an Excel formula 

"=glsu_description(xx)". The xx in the formula is a reference to another cell in the spreadsheet 

that contains a GLSU master data element (in this case, the account value in Column D).  The 

formula in Column D will return the Account master description for the account shown in cell D9. 

 

 
 

The "=glsu_description(xx)" formula will work for any master data element that GLSU pre- 

validates including GL Accounts, Vendors, Cost Centers, Profit Centers, etc. (except Field Status 

Groups). 

Specific steps to include master data texts in your spreadsheets: 

 

1. Make sure your GLSU .INI file contains the master data texts by choosing the "Text" checkbox 

for all the appropriate fields in the ZGLSU transaction. This option is valid if you are performing 

the off-line method of retrieving descriptions. If you are retrieving descriptions in a real-time 

method, this configuration option has no relevance. From the ZGLSU Transaction in SAP, 

select "Validation Options". 

 

 
 

2. Make sure you re-download your .INI file after making your text selections. 

 

3. Insert a blank column into your spreadsheet where you want the master data text to appear. 

For an explanation of how to add a blank column, see the section on Ignoring Columns. 
 

4. Optional: Type in a column description into your blank column header. 
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5. In the blank column, type the formula "=glsu_description(xx)" where xx equals the cell 

where the master data element is entered. In this example, the E column is being 

referenced. 

 

Using descriptions with a live setting in GLSU… 

 

If you are using live descriptions for certain fields in GLSU, you 

may need to perform a "Refresh Descriptions" after utilizing 

the GLSU description function. 

 

If this is the case, the text "refresh required" will appear in 

each cell. Upon selecting the "refresh descriptions" options in 

GLSU, all of descriptions will be updated from SAP. 

 

 

 

Inter-Company Transactions 

Intercompany transactions are posted using GLSU in the same way they are done through the on- 

line screens. The user will populate field NEWBK the "New Company Code" field in GLSU if they want 

the specific line item to go to a different company code than the one listed in the header of the 

transaction. 

 

IMPORTANT: You cannot populate the "NEWBK" field in the first line of a GLSU spreadsheet. 

The first line of the spreadsheet must be booked to the company code shown in the header of the 

spreadsheet. This is a requirement of the SAP interface used by GLSU and cannot be changed. 

 

GLSU will use the contents (if any) of the NEWBK field when determining if an account or other 

master data item is relevant to that company code. 

 

GLSU will use the clearing configuration already set up for your company. The inter-company 

clearing process must be properly configured for GLSU to work correctly. 

 

Populating the NEWBK field will affect all subsequent line items. 

Example:  You are attempting to post a  5 line document. You use company code 1000 in  

the header and want the 4th and 5th lines to go to company code 2000. The spreadsheet 

should be populated as shown below. Both lines shown in yellow will be booked to company 

code 2000. 
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VAT Taxes / Withholding Tax Entries 

VAT taxes are calculated by your SAP system at the time of posting. VAT taxes are calculated by 

SAP configuration that is not available to GLSU. While GLSU cannot calculate European VAT taxes 

inside the spreadsheet, it can allow transactions which contain VAT taxes to be successfully posted. 

 

Header Field XMWST is the "Calculate Tax" field. This field can be added to your spreadsheet using 

the GLSU Ribbon → Choose Fields button. 

 

A user can add the field XMWST to their spreadsheet and populate it with an "X" (see below). Once 

populated, the Calculate Tax field will disengage the standard GLSU balancing functionality that 

prevents GLSU from posting entries where debits do not equal credits. Once populated the 

balancing formula in the line item header will be changed to " – tax calc –" (see below). 

 

The user is given the responsibility of sending GLSU and SAP an entry which will be properly balanced 

after VAT taxes are calculated and added to the posting. 

 

 
 

 

 

Withholding taxes entered with customer/vendor entries are supported as of version 23.4. 

 

To add withholding tax fields, from the Choose Fields option, you can search for any fields beginning 

with “WT_” and the supported withholding tax fields will be shown.  It is important to note, like with 

other selected fields in Choose Fields, just because the field is placed on the sheet, does not 

necessarily mean the field is supported in your instance of SAP, or for that company code, 

customer/vendor account, etc.  There are no field status groups for withholding tax fields in GLSU, so it 

is up to you to properly select and populate only available fields in your system.  When in doubt, 

perform a manual entry first to verify fields available for input for the master data you have selected. 

 

Withholding tax fields introduce a 3rd dimension of input in GLSU, which means you can have multiple 

withholding tax records for one customer/vendor line.  This is represented as follows in the GLSU sheet.  

You will have one customer/vendor line and then 1 to many tax lines that immediately follow but are 

NOT on the customer/vendor line. 
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Withholding tax fields are available for customer/vendor account types only.  If you place withholding 

tax lines following any line item other than a customer/vendor line, you will receive a validation error 

when validating. 
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Document and Line Item Long Texts 

 

GLSU allows you to input document and line item long texts on each document. These text fields are 

not the same thing as the document header text (BKTXT) or the line item texts (SGTXT). Long Texts 

allow you to input multiple-line formatted texts. Long Texts for Park Documents are also supported. 

 

• Header Long Text field names begin with "BELEG" 

• Line Item Long Text field names begin with "DOC_ITEM" 
 

These are in the header and detail sections, respectively, of the possible fields listing in the "Select 

Fields" dialog box (shown below). NOTE:  You will see a listing for each of the Header and Line Item 

Long Texts fields that you have configured on your system. You will need to ask your SAP 

Administrator which the appropriate field is to populate. 

 

• Configure Header Line Texts using transaction OBT8 

• Configure additional Line Item Texts using transaction OBT10 
 

After you have made your configuration changes, you will need to either go to SAP transaction 

ZGLSU and do Send Validation Now, or from Excel, select Utilities → Retrieve Validation Data in order 

to be able to access the updated text fields from the GLSU spreadsheet. 
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A note on formatting long texts… 

 

1. The semi-colon ;;  is used as a newline character. If you wish to start a new line, you may  

either type the semi-colon character or choose Alt-Enter from your keyboard. The semi-colon 

character will NOT be displayed in the long text. 

2. Use the tilde ~~  character on either side of a formatting option. The formatting characters 

available on your system may vary from those shown below. See Example graphic below…. 
 

NOTE: The total length of long text lines may not exceed 72 characters; this is an SAP hard limit which 

cannot be changed by GLSU. Long texts are also limited to non-split documents only, but are 

available for multi-sheet and dropped header. 

 

If the posting timeout is reached in GLSU as set by the Premium User Functions → Maintain Technical 

Options → Job Wait Time setting, long texts will NOT be updated for the posted worksheets. SAP 

cannot create a link to the document because no document numbers will be recorded until the 

SAP job runs. 

 

 

EXAMPLE: Formatting 

; 

~ 
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Double-Byte (East Asian Languages) 

 

GLSU supports the use of double-byte character sets. If you intend to use GLSU with one or more 

double-byte characters sets you will need to make a couple of changes detailed below. 

 

You will need the "Unicode RFC Libraries" on the desktop in the SAP GUI. This can be found in the 

"Development Tools" section during the SAP GUI installation procedure for 6.40 and earlier. For SAP 

GUI 7.10 or later this is automatic. If you are unsure what you have installed, please contact the 

department responsible for SAP GUI deployment. 

 

First, open your SAP GUI settings and open the "Code Page" settings. Under Upload/Download 

Encoding, you will need to select "Unicode (UTF-16LE)" and select "OK". Repeat this step for each 

double-byte SAP system you will use with GLSU. NOTE: If you cannot change these settings, you may 

need to speak with your desktop administrator group or the group who handles the deployment 

and maintenance of the SAP GUI. 

 

Second, if GLSU is already installed, open Excel and perform the following steps: 

From the GLSU menu... 

1. Choose "Options". 

2. Choose "General" tab. 

3. Turn "Unicode File Handling" to "On". 

4. Select "OK". 

After you have performed the steps necessary to enable support for double-byte character sets,  

you can ensure GLSU is able to display these sets by performing a "Pick Values" on any supported 

field. Pick a company code which you know contains double-byte character sets. You will see a 

display similar to below. In this example, both Korean and English texts are displayed simultaneously. 
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Document Attachments (BDS) 

 

GLSU supports the attaching of the spreadsheet file to the posted documents in the SAP BDS  

(Business Document Service) for supplemental documentation and audit purposes. Regular postings, 

parking, accrual/deferral and posting foreign currency transaction types are all allowed with the 

document attachment feature. There are several ways this functionality can be configured. 

 

Important Note: Any Premium or Standard user must select the "Send Validation Now" option from 

the ZGLSU transaction for these settings to take effect. 

From a Premium user perspective, you can set the options so certain options are always enforced or 

can be determined by the end user. 

 

From the ZGLSU menu (logged-in as a GLSU Premium user) in SAP… 

 

1. Choose "Premium User Functions" 

2. Choose "Maintain Technical Options" 
 

 

If you choose "YES", the spreadsheet will always be attached to all SAP document numbers. 

If you choose "NO", the spreadsheet will never be attached to the SAP document. 

If you choose "PROMPT", the user will be prompted whether or not to attach documents. NOTE: The 

user will not be able to set options in this setting. They will always be prompted what action to take. 

If you choose "USER", the options on the end-user desktop will be enabled and the user will be able 

to set their own options accordingly. 

You can also configure what description will be used in the BDS for the attached documents. This 

can be a combination of hardcoded text elements and parameters from both the workbook and 

the SAP system. For a listing of the available parameters, put your mouse cursor on the description 

field and select "F1". The next screen will be shown. 
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Max Attachment Size: Allows the Premium user to set the maximum attachment size for standard 

users. This allows very large workbooks from being attached in order to manage the load on the SAP 

database. 

Use link for subsequent attachments: GLSU can attach a workbook to the first document produced 

and then attach a link to that workbook on any subsequent documents. This saves space in the SAP 

database. It is ON by default. Some installations may not be able to take advantage of this feature 

due to SAP version and/or configuration. 
 

 
 

Please keep in mind that reserved words must be enclosed in angle brackets ( < > ). If they are not, 

the literal word will be substituted in the description. NOTE: These selections must be typed in. The 

display is only to inform you of what options are available. 

 

If the "USER" option is selected by the Premium user, all of the options available for storing 

documents will be in the control of the standard user. 

 

From the GLSU menu in Excel… 

 

1. Choose "Options". 

2. Select the "Attachments" tab. 

NOTE: This tab will only appear if the Premium user has selected an option other than "NO". 

 

If the posting timeout is reached in GLSU as set in the Premium User Functions → Maintain Technical 

Options → Job Wait Time setting, BDS document attachments will NOT be updated for the posted 
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worksheets. SAP cannot create a link to the document because no document numbers will be 

recorded until the SAP job runs. 

 

 

 
 

From the Options screen, you can select a 

configuration that suits your needs. If the 

Premium user has selected "forced" options, 

that setting would be displayed here and the 

other options would be disabled. 

 

Attachments with split documents: 

When a GLSU document splits based on the 

"Maximum input lines per Doc" as configured 

in transaction ZGLSU, GLSU will attach the 

spreadsheet to all of the split documents. 

 

Attachments with inter-company documents: 

When a GLSU document is an inter-company 

document (denoted by NEWBK in your 

template. GLSU will attach the spreadsheet 

to the header document ONLY. A logical link 

exists in SAP under the intercompany 

document number. 

 

Excel/GLSU functionality when inside the 

Business Document Navigator: 

If you wish to perform additional functions 

with it rather than just using the Excel 

functionality within the Business Document 

Navigator, we always recommend extracting 

the source document from the BDS. If GLSU 

descriptions or other GLSU functions contain a 

"#NAME", select "Reset Links" to repopulate 

the cells. 

 

 

An additional feature is available to allow the user to see the workbook size on disk. This is especially 

useful when the "Max Attachment Size" has been set low. Any workbook over this maximum amount 

will not be attached. 
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1. Click on the "View Workbook Size Report" button. 

 

2. The user will be presented with a quick summary report… 

 

3. Click on the "Show Sheet Size Report" button... 

 

4. This report will show each sheet and its approximate size in bytes. It can be very helpful to 

find those over-size sheets and deal with them before posting and attaching. 

 

5. Clicking on the sheet name will show it as the active sheet for your review. 
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Attaching Multiple Documents and Files 

 

In versions of GLSU prior to 6.2, only the current worksheet was attached to the posted document. 

Whe a document posts, the current worksheet is presented for attachment an cannot be deleted. 

However, the “Multiple Attach” feature allows the user to select one or more additional documents 

to be attached. Practical examples might be additional workbooks, Word documents, images of 

receipts, delimited source data text files.  All file types are permitted. 

 

If the user has selected to attach documents (discussed earlier in this BDS section), then the 

following dialog will display before the document post process begins. This allows the user to 

add/delete files of any kind. As noted, the only document that cannot be removed from the list is 

the current workbook. Here is what the user dialog looks like: 
 

 
 

Simply add the files using the pop-up file browser. GLSU keeps track of the files and their sizes. Notice 

the “Max Allow Size” value. This is set by a Premium User in the ZLGU under the “Premium User 

Functions” screens and is the same for all GLSU users.  The “Remaining” value helps users to keep 

track as they add files. Exceeding this value will produce a clear error. 

 

 
 

Double-clicking a file will give the user the opportunity to remove a file from the attachment list. 

Note that the user is not given this option when double-clicking the required worksheet file. 
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After the document is posted, another dialog will display showing the attachment process and 

results. All files can be found attached to the posted SAP document. 

As of GLSU 7.0, Excel workbooks downloaded from SharePoint, OneDrive, or any other cloud-based 

file repository are now able to attach to posted or parked SAP documents. Additional files such as 

(but not limited to) images, additional Excel workbooks, PDFs, and Word documents can also be 

attached. However, the additional files must be present on a local or network drive. The file 

attachment dialog provides a file browser to help you locate files and add files the attachment list.  

If these additional files are stored on a cloud-based repository, they would need to be downloaded 

to your local or network drive first in order to be visible to the file attachment dialog. The current 

workbook, as always, is attached and cannot be removed from the attachment list. 

 

 

Integration with EWF (Easy Workflow) 

 

GLSU supports integration with EWF, another Insightsoftware solution offering a robust workflow 

solution.  The following describes features and functionality ONLY available if you are also using EWF. 

 

When using an integrated GLSU-EWF solution, certain functions and the ability to update certain 

fields within the spreadsheet will be unavailable during the EWF process.  For instance, during an 

approval process, the spreadsheet will be protected as a control, to ensure the contents and data 

of the spreadsheet do not change from the original used at the very beginning of the workflow. 

 

While certain context sensitive fields and functions will be disabled to the user, this does not mean 

no fields will be updated during an EWF enabled GLSU process.  Please refer to the screen below. 
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In this case, 3 document postings were attempted, but only 2 were successful.  Since the 2   

successful documents represent a logically completed unit of work (a balanced and error free 

journal posting), they are posted.  The 3rd document displays “SAP ERROR” since a backend SAP  

error was encountered which the pre-validations did not catch. In this case, this workflow is sent 

back to EWF for further processing according to the EWF rules which have been configured. Once 

resolved, it will progress through the workflow again and appear as in the screen below. Again, only 

the user with create/edit authority in EWF will be able to modify the entry. 
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Note: Special EWF processing for errored documents will occur in regular, cross company (inter- 

company) and dropped header documents.   For split documents (individually documents with 

more than 999 lines items), any errors will need to be corrected like they are with regular GLSU 

processing in the SM35 batch session. This is because the balancing entry for each document is 

contained only in the session (not in the spreadsheet).  Furthermore, the integrity of the spreadsheet 

needs to be maintained for auditability purposes, so modification does not make sense. 

 

 

Closing Metrics Report/Dashboard 

 

Starting in version 23.1, GLSU will generate an in-workbook worksheet which contains select GLSU 

document processing metrics.  This report can be run for a single or dual periods and for yourself or 

all GLSU users (premium and standard if “all” is selected). 

 

From the GLSU menu in Excel… 

 

1. Select “Initialize” 

2. Select Radio button “Create Run Statistics Sheet” 

3. Select “ok” 

4. Enter your from Date/Time selects for a one or two period report 

5. Select “all” or your user ID 

6. Select “ok” 

7. A new sheet is generated starting with “Statistics_Sheet” 

If you ran a single period report the sheet will contain contents similar to the following: 

Date UserID Company  Docs Time Mean 

12/12/2022  TESTUSER1 3000 6 1:22   0:14 

12/21/2022  TESTUSER1 3000 1 0:05   0:05 

TESTUSER2 3000 4 0:38   0:10 

 

Totals: 11 2:05   0:10 

 

If you ran a dual period report, the sheet will have two reports displayed side-by-side and addition 

graphical charts showing a percentage comparison of the data. 

 

You can use this report to gauge processing volumes and times between close periods. You can 

also run it during a close cycle to quickly spot anomalies in processing which may stray from 

expected norms. 
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GLSU SAP Features 

Besides posting your .ZGL file to SAP, the GLSU ABAP program also controls many other options. 

 

 
 

Standard Users will not see the "Premium User Functions" button shown above. Only Premium Users 

will see this option on the screen. 

 

The following pages explain the ABAP functionality in greater detail. 
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Setting your GLSU Validation Options 

The GLSU ABAP program will allow you to configure the GLSU validations to your requirements. 

 

The GLSU ABAP program can be accessed by typing transaction "ZGLSU" in the box at the top of 

your SAP GUI. 

 

Master data may be downloaded to your PC each time you run the ABAP on an ad hoc basis or in 

a real-time (live) fashion. 

 

You may individually select or de-select certain SAP master data items as you require. For example: 

if you never post to customers or profit centers, de-select those items, and your validation update 

process will execute faster when in offline mode. 

 

 
Select the button that says "Validation Options" in the ZGLSU transaction. 

 

The following explains each of the fields in the Validation Options dialog box… 

1. Master data checkboxes: Activate these checkboxes if you wish to download these master 

data values to your PC. 

2. Text checkboxes:  Activates these checkboxes to download the text values (labels) for the 

associated master data value. These default to the OFF position. By turning these on, you can 

see a "search-help" dialog box in the Excel spreadsheet. See next page. 

3. Premium Only - Suppressed / Required / Optional radio buttons:  If you are a Premium-level user, 

you will have the option to make selected validation fields either Suppressed/ Required or 

Optional. This is similar to the way SAP Field Status Groups works. By Suppressing or Requiring 

individual fields, users will not have the option to make their own choices about whether they 

validate for these fields or not. These radio button selections affect the entire GLSU installation for 

your SAP system and affect every user. Standard Users will not have the capability to change 

these selections. These radio buttons also have no relevance when a master data item is 

selected to be "Live". 

4. Premium Only - Off-line (.INI) or Real-time (Live): These radio buttons will tell GLSU the source for 

pre-validations, pick values, and descriptions. If you choose off-line, all pre-validations, pick  

values and description values will come from the off-line file that is sent to your workstation. If you 

choose "Live", all pre-validations, pick values and descriptions will come from SAP in real-time. The 

more "Live" validations you configure, the smaller the PC footprint. 

5. Company Codes to Validate:  Choosing a range of company codes will limit all master data 

values to these ranges of companies (when the validation is set to the .INI setting, this is not valid 

for real-time validations) If there are company codes at your organization which you never use 

or post entries to, then omit them from your selection here. Those values will not be saved on  

your PC’s validation file. 

6. Sort Fields Radio Button: This radio button controls the sort order of the pick list in the GLSU 

spreadsheet. 
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7. Save Changes: You must click on the "Save Changes" button for GLSU to store your selections. 
 

 

You can also select ranges of master data to be sent to the .INI file. This will allow you to exclude 

ranges of master data that you do not normally use. 

 
 

For instance, if you do not use all the company codes which have been configured for your 

organization, you can limit the range of company codes to a specific range or list of individual 

values. This will work for each of the master data elements that GLSU validates. 

 

 

In short, if you do not use the data item, do not send it to the .INI file. This will improve the processing 

performance of GLSU. 
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Processing "Export" Files 
 

GLSU "remembers" all the settings you used the last time you posted a document through GLSU. 

Every time you run ZGLSU, the filename, batch log name, etc., will be auto-populated with the 

values from your last posting. You simply edit these values as necessary, then run the program. 
 

 
 

PC Spreadsheet Output File:  If you need to search your hard drive, you can click the file dialog 

button, then use the Standard Windows dialog box to locate the .ZGL file… 
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Maximum # of Document Line Items 
 

You can have GLSU limit the number of lines which are 

posted on a given entry. You may want to do this 

because your entries are longer than 999 lines (SAP’s 

internal limit) or because you are posting documents 

with taxes (which book more FI line items than are 

entered by the accountant). 

1. Maximum Input Lines per Doc:  This parameter 

controls how many lines each SAP document will 

have. When this limit is reached, GLSU will start a 

new document until the lines are fully posted. 

2. Append Counter to Ref Doc?: You have the option 

to auto-increment each document if more than 

one document is posted. This sequential counter is 

placed in the last digit of the reference doc field. 

3. Balancing Account Info: Clicking on the 

"Balancing Account Info" button will display the 

following dialog. Enter the appropriate posting 

values for your balancing account and save. 
 

 
 

 

 

 

If you are posting to 

accounts which use taxes, 

you may want to limit your 

maximum input to 150 

lines. 

 

SAP books multiple line FI 

lines for accounts using 

taxes. 
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Upload File History 

 

The second section of the ABAP lets you view the files you have previously loaded using GLSU. GLSU 

can prompt you if you are attempting to load the same file name in consecutive attempts. GLSU 

can also delete the upload file after processing (if this option is chosen) to prevent the same file 

from being loaded multiple times erroneously. This is a good option to leave ON. GLSU will also 

delete all posting history attached to your ID if needed. 

 

 
 

The following explains each of the fields in the Upload File History section… 

1. Check Upload History: Leave this checkbox on if you want GLSU to check its history to 

potentially detect erroneous double-postings of entries and prompt you if you want to 

continue. If the checkbox is ON and GLSU does find the file in its internal history, it will stop the 

posting process. You will need to rename the .ZGL file or turn this checkbox OFF to continue. 

2. Delete .ZGL file after upload:  Leave this checkbox on if you want the GLSU ABAP to 

physically delete the .ZGL file from your PC after posting. This will eliminate any chance of an 

erroneous double-posting. 

 

 

3. Show Upload History:  Clicking on this button will display the dialog box shown above. It 

shows files which have been posted to SAP under your SAP login ID. It shows file name, date, 

time and SAP document numbers. 

4. Clear Upload History:  Clicking on this button will delete ALL history from SAP about what files 

have been loaded under your ID. 

5. The "Print Upload History" option will display an SAP printer-friendly version of the listing (see 

below). 
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Spreadsheet Templates 
 

Spreadsheet Templates can be stored on your SAP server. This functionality allows the efficient 

distribution of templates to your SAP users. It also allows for your users to get a quick head-start when 

using GLSU for the first time. 

 

Standard Users can download the templates. Premium Users can Download, Upload, Rename and 

Delete the templates which you have stored. The following pages explain the Premium User 

functionality in greater detail. 

 

DOWNLOADING a template from SAP to your PC is an easy process. There are two ways to do this. 

You can download the template from the SAP ZGLSU transaction or from the front-end. Let’s look at 

the GLSU front-end method first. 

 

1. Start by clicking on the INITIALIZE button. 

Initialize 
 

 

2. Click on OK to bring up a list of templates… 
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3. Select a template by clicking on it. 

 

 
 

4. The GLSU system will pop-up a file explorer screen. Use this to place the template file 

wherever you like on your system. You can change the name at this time to something that 

suits your workflow. 
 

 

5. The end result will be a fully formed template, possibly partially filled in by your Premium user 

with required field data. 
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6. Make whatever modifications you need to: add lines, change dates, etc., and post or park 

the document as usual. The template is simply meant as a starting point to maintain some 

consistency from document to document. 
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The alternate way to select and download templates is by using the ZGLSU transaction. 

 

 
 

1. Click the "Download a spreadsheet template" button from the ABAP program ZGLSU. 

2. Highlight the appropriate template and click the "Choose" button. 

3. Use the standard Windows dialog box to choose a file name and directory on your PC to 

store the file. Click the "Save" button when finished. 

 

 

Premium Users will be able to maintain the Spreadsheet Templates that are stored on your SAP 

system. Premium Users will be able to upload new templates from their PC to SAP. Premium Users will 

also be able to rename the templates which are stored on the SAP server. If you do not have access 

to this functionality, you will need to be set up as a Premium User, or have your Company’s Premium 

User do this for you. 



  page 116 

 

 

NOTE: Templates are not changed on the SAP server. Changes which need to be made to the 

structure of the template must be done inside Excel. Once saved, the edited spreadsheet file can 

then be uploaded to SAP. 

 

To access this functionality… 

1. Click the "Premium User Functions" button on the ABAP screen transaction ZGLSU. 

2. Click the "Maintain Templates" button 

3. Click the add, rename, or delete buttons, see instructions below. 

 
 

The following pages explain how to upload, rename, and delete the GLSU templates which are 

stored on your SAP server. 
 

 

 

 

The SAP system choice 

does not take effect until 

GLSU is logged on to the 

appropriate SAP system. 

 

GLSU stores each unique 

SAP system and client’s 
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data in a separate .INI on 

your system. 
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To UPLOAD a new Spreadsheet to the SAP server: 

1. Click the Upload Template icon. 

 

2. Locate the spreadsheet on your PC using the standard Windows dialog box shown below. 

When found, click the "Open" button. 
 

 

3. Use the following dialog box to name the spreadsheet template on your SAP server. 
 

 

4. Click the "Check" icon when finished.  
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To RENAME a Spreadsheet Template which is already stored on your SAP server, perform the 

following steps…. 

 

 

1. NOTE: This functionality is only available to Premium Users. 

2. Click the "Premium User Functions" button from transaction ZGLSU. 

3. Click the "Maintain Templates" button. 

4. Highlight the appropriate spreadsheet you wish to edit and then click the "Rename" icon at 

the bottom of the screen shown on the previous page. 
 

 

5. Type in the new name of the template in the dialog box which then displays. 
 

 

6. When finished, click on the "Check" icon.   

 

To DELETE a Spreadsheet Template which is already stored on your SAP server, perform the following 

steps…. 

 

 

1. Note, this functionality is only available to Premium Users. 

2. Click the "Premium User Functions" button from transaction ZGLSU. 

3. Click the "Maintain Templates" button. 

4. Highlight the appropriate spreadsheet you wish to edit and then click the "Delete" icon at 

the bottom of the screen shown on the previous page.  

5. Click "Yes" in the following dialog box: 
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Importing Data into a GLSU Template 
 

GLSU has a utility to allow data to be imported from a file directly into a template. The data must be 

delimited with a comma, pipe, tab, or other delimiter that can be specified. The import system is 

great for pulling data exported from Excel, SAP, or another system directly into GLSU. The import is 

fast and can be a great time-saver. Further, if the data is available on the record, an offsetting entry 

can be built. This is all done in a user-friendly data preview and mapping environment. 

 

To get started, click on the IMPORT icon on the menu: 

 

 
 

 

1. Use the BROWSE button to find data files on your hard drive or network. 

2. "My data has headers": If your data has headers on record #1 check this box. If no headers are 

available you can continue, but it makes mapping more difficult. 

3. Select a Data delimiter. This will let you see if the delimiter is the right one for the file and gives 

the user visual confirmation that the data will import properly. 

4. Enter the number of records to show in the preview window. This value is also used to constrain 

the number of preview records on the mapping screen. 

5. The preview area will show the data records as they will appear  in the data mapping screen. 
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6. Click "MAP FIELDS" to open the data mapping screen shown on the next page. 
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The Data Mapping Screen 

 

 

 
1. Primary Map: This area is for data file record fields to GLSU template fields. 

2. Offset Map: This area works the same as the "Primary Map" except that it is mapped so that 

an offset entry will be produced. 

3. Checkbox "Use offset map": Turn ON/OFF the "Offset Map" feature. Many mappings will not 

use this feature but it is here when needed. 

4. Save and Exit: Save the map for use later. Maps are saved in the workbook by sheet so that 

they will be available when the workbook is opened again later. 

5. Save and Import: Save the map to the workbook AND proceed to import the data into the 

GLSU template. Don’t worry. If the data is not mapped correctly, you can come back and 

modify the map, then reload the data again. 

6. Preview: The data preview pane shows one record at a time vertically to assist in field 

mapping. 

7. Preview Navigation: The NEXT and PREV buttons step through the preview record set. Note 

that the mapped data changes on the left as the preview record changes on the right. 
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Mapping the Data 

 

To map the data coming from the record to the GLSU template fields simply click-and-drag the 

data set from the "Example Data" window to the left and drop it on the "Primary Map", in this 

example. Drag over one data field at a time until you have completed the data mapping. Use the 

PREV and NEXT buttons to step through the records. The data in each window will change showing 

just how the data map is working. Note that the import mapping will only step through the records 

that were previewed on the prior screen. If more records are needed to visualize all of the different 

types of records that will be imported, save and exit this screen, change the PREVIEW value from 10 

to something higher, and then re-enter the data map. 

 

Use the "Clear Single Link" button to undo a mapping for a single data element. 

 

Use the "Clear Primary Map" to clear out ALL of the mappings for the Primary Map. There are similar 

buttons available underneath the "Offset Map". 
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Importing Data 
 

 

There are several import options available on the "Import Data" screen. 
 

 

 

 
 
 

Press button Import and Exit to start the 

import. The process bar and record 

counter will show the import progress. 

   
Make sure you have the 

sheet active that you 

want to import the data 

into. The name of the 

sheet will show into the 

caption of the “Map 

 

1. Import ALL records: The system will import as many records as the file contains. 

...or... 

2. Import only a subset of records: Enter the number of records to load. This is useful when 

testing your map all the way to actually importing a small subset of the records in the file. 

Once everything looks good, use the "Import ALL records" and "Clear my line items and 

import the data" settings together to clear the template and import all of the data 

records. 

1. Clear my line items and import the data: This removes ALL of the data from your GLSU 

template before importing the data. 

...or... 

2. Import the data appending it to the existing line items: This setting appends the imported 

data to the end of your GLSU template. It is useful when you have two or more files that 

are formatted exactly the same but contain different sets of data; e.g., one file per 

week, per company code, etc. 
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Importing Data – Advanced 

 

With the introduction of the IMPORT feature two new keywords have been created: REF1 and REF2. 

These "Reference" rows in the GLSU template work with the IMPORT feature to build moderate to 

highly complex data imports. Here is an example of what one looks like a GLSU template. 

 

 
 

The REF1 line is tied to the Primary Map, and REF2 is tied to the Offset Map. 

Let’s take REF1 for example. Normally, when a Primary Import map is created, you map what you 

like and may or may not leave some column blank. If there is no REF1 row the missing values will 

import as blank as expected. However, what if the requirement is that the posting key is 40 for every 

row? 

 

Looking at the example above notice that REF1 has a posting key of 40. This is constant. As long as 

the Posting Key column is not mapped, the value "40" will be used for every primary record. Some 

imports may only have a 1:1 correlation between the number of records in the file and the number 

of records being imported. However, if an Offset Map is created, we have a 1:2 correlation 

between the number of records being imported and the number of records actually imported. The 

Primary Map will always import data but the Offset Map will import data only if it is turned on in the 

mapping screen. 

 

Let’s take a look at the mapping screen for the example above. Notice how the map displays the 

incoming data with a REF1 row in place. 

 

 
 

Notice how the REF1 value "bleeds through" to the Primary Map. This means that for every row that is 

imported the value of posting key will be 40. It’s a constant. 

Field” screen. 
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The same is true for the Offset Map and the REF2 row. In this case, the Offset Map would have blanks 

(unmapped columns) for both Posting Key and Account. The REF2 row will fill in those blanks as the 

records are imported. 

 

There are a few neat tricks that the REF rows can be used for. How about coloring the background 

of the REF1 row light green? The effect would be that the import data would load and produce a 

"green-bar paper effect". REF1 and REF2 lines like this … 

 

 
 

...would produce this look in the imported sheet. It could help when trying to determine which 

imported records are from the Primary Map and which records are from the Offset Map. 

 

 
 

Note that the REF1 and REF2 rows can be hidden once they are set up and tested. 

 

What about calculations? Yes, calculations can be used as well. It is possible to derive data for, say, 

the Profit Center column, based on Account and anything else on the imported sheet. A VLOOKUP() 

could be used on Account to lookup the associated Profit Center, for example. 

 

Note also that if only the Primary Map is filled in and the Offset Map is "inactive", then only a REF1  

row will be needed. Having a REF2 row will have no effect. If the goal is to have the REF2 row fill in all 

of the columns for every record loaded, then the Offset Map would be activated but not mapped 

and a REF2 with constants and/or calculations would be supplied. Perhaps all of the columns in the 

offset row are always the same and only Amount value changes from record to record. In that case, 

use the above approach but map the Amount column in the Offset Map. 

 

You can load a “fixed length file as follows: 

 

1. Use Excel’s “File Open…” (fixed-width mode) to pen and slice the file into columns as desired. 

2. Save the resulting workbook as a Tab-Delimited (.txt) or Comma Separated variable (.csv) file. 

3. Use the standard import method for delimited filed to load the data into your GLSU template. 
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Embedding Custom GLSU Buttons into a Template 

It is useful at times to be able to build a template and add your own buttons for VALIDATE and POST. 

GLSU allows you to do this quite easily so that your most-used menu actions are embedded in the 

template. 

 
The first step in this process is to get access to the Developer Tab: 

1. Go to File → Options 

2. Click on "Customize Ribbon" 

3. On the right-hand side, check the box next to "Developer" 

 

 
 

After hitting "OK", the standard Developer tab will be visible on the Excel Ribbon. 
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Now we need a button added to the menu. To do this, click on the insert icon and insert a button 

object. Initially the button will be named "Button 1" but we will change that. 

 

 

 
 

Place your button where you prefer it. Size it if needed. If the button doesn’t have an "edit border" 

around it then simply right-click on the button to turn on edit mode. 

 

In edit mode for the button, look for selection "Edit Text" in the right-click menu. Name the first button 

"VALIDATE". Now all that is needed is to tie the button to a macro. While in edit mode, select "Assign 

Macro". For the Macro Name enter "GLSUValidate" and press OK. Test the button by clicking on it. 

The action should be exactly as though you had clicked on the GLSU Validate menu item. 

 

Create a custom "Post" button using the same procedure. Simply add a new button as before and 

right-click on it to get the edit mode, and the edit menu. Edit the text to say, "POST". Again, in edit 

mode, edit the macro to read "GLSUPost". You’re ready to go! 

 

You can go into edit mode (right-click) on any button as needed to change the text, the macro 

name, or to resize or move the button into place. 



  page 131 

 

 

 

GLSU SAP-Side Installation Check (Technical/Project Team Utility) 

 

To aid in the diagnosis of installation, configuration, and security role issues, GLSU comes equipped 

with an installation check utility. This utility can be run by all licensed GLSU users, both Premium and 

standard. It can be used to help internal BASIS personnel or insightsoftware support staff. Since the 

utility runs for a particular SAP user ID when diagnosing issues, the utility should always be run under 

the SAP user ID in question. 

 

To run the GLSU installation check, go to transaction ZGLSU in SAP and then type "check" in the SAP 

command box. 

 

The GLSU installation checker checks these items: 

 

1. Transport import of GLSU data transports. 

2. Open, write, transfer, close, and contents of temporary work files on local and remote SAP 

application servers. 

3. Generation status of SAP standard load programs. 

4. Authorizations for posting, parking, accruing, batch session management, file system access, 

immediate job submission, and the various RFC requirements needed to connect from Excel. 

If an SAP authority object is checked, the authority object and the arguments will be shown. A 

"green light" (square) indicates the check was successful for the SAP user ID under which the check 

was run. Any color highlighted other than "green" indicates that the check failed and may require 

attention. 
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Premium Only – Default and Hidden Field List 
 

As a Premium user, you can configure the possible SAP fields which will be displayed and defaulted 

in Excel. This promotes ease of use and lack of confusion for fields which your company may never 

use or use infrequently. 

 

To configure the list of default and hidden fields perform the following… 

1. Start transaction ZGLSU. 
 

2. Select "Validation Options". 
 

3. Choose option "Select Hidden and Default Fields" (at the bottom of the screen, you may 

have to scroll down). 
 

4. Check the appropriate options for fields you wish to Default and fields you wish to suppress 

from display (NOTE: Suppression does not cause the field to be unusable in GLSU, it simply 

does not display the field in the possible fields list as the default). 
 

 

Hidden and Default fields, since they are relatively static, require a "Send Validation Now" operation 

in order to be updated the next time a spreadsheet is initialized. 
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These settings will be applied each time a GLSU spreadsheet is initialized. The settings are not 

applied when editing an existing worksheet. 

GLSU on Fiori 

The GLSU transaction code ZGLSU now supports use as a tile in Fiori.  A Fiori tile will not be delivered as 

part of the GLSU installation (no modification of SAP objects allowed) package, but can be easily 

added using standard SAP practices for adding custom tcodes as Fiori tiles in the location which is 

desired by the customer in the Fiori Launchpad. 

You may use the Fiori tile as you would a regular SAP tcode in most respects.  There are some 

limitations to functionality due to the security environment in a web browser.  A message will display 

indicating so if the specific function is not available.  For “Send Validation Now”, customers should 

instead use “Retrieve Validation Data” in the Excel GLSU Ribbon which performs the exact same 

function.  A reminder that in Excel you can set this to be automatically refreshed once, per Excel 

session.  Lastly, performing a 2-step troubleshooting session will need to be done by a user who has 

SAP GUI or alternatively, a Premium User can set the “Never Delete BDC Sessions” technical option 

either temporarily or permanently.   You can then run SM35 and troubleshoot your entry. 

Technical Note: Customers wishing to go to zero-client SAP GUI installs, may do so as long as the SAP 

“Unicode RFC Libraries” are installed.  Please see your IT/SAP GUI administrator for more information. 
The document drill-back functionality will not work if the customer only has SAP Fiori.



  page 135 

 

 

Premium Only – Maintain Technical Options 

 

From the ZGLSU transaction in SAP (logged in as a registered Premium user)… 

 

1. Select "Premium User Functions" 

2. Select "Maintain Technical Options" 
 

 

 
Job Wait Time(sec): Allows you to synchronize GLSU with the parameters you have set for batch 

processing at your company. After the specified number of seconds, GLSU will return a message to 

the user saying that they need to try their posting again later. NOTE: When job wait times are 

reached, neither long texts nor BDS document attachments can be saved because no document 

numbers will be recorded until the SAP job runs. 

 

Doc Retention (days): This option will control the amount of time that GLSU remembers files that are 

uploaded by each user. GLSU will "forget" filenames loaded by users when they become older than 

the number of days specified. 
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Disable Load Balancing: When selected, this option will force the background job to run on the 

application server that the user is logged into. When not selected (the default setting), the 

background job is run in an available batch work process like any other job. 

 

Maximum Rows Returned for Live Pick Lists: The value entered here specifies the maximum number 

of records that will be retrieved (to avoid long runtimes) for real-time (live) pick values. The default 

value is 1000 entries. 

 

Job Class: This option specifies which job class GLSU background jobs will be submitted as. The 

possible entries are Class "A" – High Priority, "B" – Medium Priority, or "C" – Low Priority 

 

Max SQL Statement Size: This value denotes the maximum size of a database SQL statement. 

Depending upon your SAP database, this value may need to be adjusted. You should contact your 

DB administrator before you change the default value.  NOTE: The default 64K value will not need to 

be adjusted in approximately 95% of GLSU installations. 

 

Submit As Non-Unicode: With application of SAP note 723363 and/or certain versions of SAP (4.7 

support package SAPKH47023 and ECC 5.0 support package SAPKH50005), an option was added  

by SAP to the standard load program to submit as non-Unicode. For installations which are known to 

be non-Unicode, this setting should be checked initially unless otherwise determined by Z Option 

support. 

 

Custom Validations: GLSU can be configured (along with development) to handle custom  

validation scenarios. Custom validation development can be done via your internal development 

resources, or outsourced for a fee. Any header or detail fields can be validated, either on a line by 

line or total document basis. Drill-back to the Excel spreadsheet cell is supported. Errors are denoted 

in Excel by "CV-E" (Custom Validation Error). Only "errors" are supported at this time. Users must select 

"Retrieve Validation Data" from the GLSU → Utilities menu option OR "Send Validation Now" from the 

ZGLSU transaction within SAP for the new setting to take effect. Custom validations are only 

supported with a live connection (i.e. not supported in the off-line mode). 

 

Full development documentation is provided in the /ZOPTION/GLSU_LIVE_CUSTVAL function module 

(Transaction: SE37) available on your SAP system after GLSU has been installed. 

 

Perform SAP Substitutions: Reserved for future use. 

 

Perform SAP Validations: Activate GLSU pre-validations for Financial Accounting line item validations 

and Cost Accounting line item validations. These are the same SAP validations as configured in  

OB28 and OKC7 respectively. 

 

NEVER Delete BDC Sessions: When this option is checked, GLSU will never delete the sessions 

contained in transaction SM35, whether they are successful or not. 

 

Use Header Company w/split: Activating this option will place the header company of the workbook 

as the header company on EVERY SAP split document which is created when the number                 

of lines exceeds the "Maximum Input Lines per Doc" value. With the option de-selected, the last "New 

co.code" (Technical Field: NEWBK) value set will be placed on each respective split document. 

 

Attaching Documents: See section Document Attachments (BDS). 
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Transaction Control: This section allows the Premium user to control globally which transactions can 

be used by all GLSU users. The checked options will be the only ones available in the Options screen. 

Note that on a clean installation GLSU will not immediately know these settings. However, as soon as 

a GLSU user attempts to post or park they are required to log in. It is at this point where GLSU will 

determine which transactions are allowed and which are not. Premium users are exempt from these 

settings. 

 

Enable Field Selection and Template Creation for Std. Users: This option controls whether or not 

standard users of GLSU can access the "Choose Fields" menu item. It might be used in conjunction 

with the GLSU template download feature to get all users of GLSU in an organization using the same 

consistent templates without the ability to edit their fields. Premium users are exempt from this  

setting. 

 

NOTE: Only Premium Users will be allowed to maintain these technical options. Z Option 

recommends that you consult either insightsoftware and/or your BASIS administrator before 

changing any of these settings from their default values. 
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Premium Only – Create Off-Line Validation File 

 

Since GLSU offers two methods to validate, Off-Line and Real-Time, it may be a requirement to 

create a validation file for an external user or business partner (Vendor, etc.) independent of the 

site-wide configuration configured by the Premium User. 

 

For example, in your GLSU configuration you might have selected all fields which are available for 

"Live" validations. This configuration creates the minimal footprint on the PC workstation. This is an 

optimal configuration for an in-house user with direct access to SAP. However, many customers use 

GLSU to create spreadsheets which can be used off-line. Since the pre-validation, pick lists, and 

descriptions are major features which would be lost if the external user was given a local validation 

file (.INI), we provide the "Create Offline Validation File" function available to only Premium users. 

 

In order to create an off-line validation file perform the following 

steps… 

 

1. Log in to SAP. 

2. Execute transaction ZGLSU. 

3. Select "Premium User Functions". 

4. Select "Create Offline Validation File". 

5. Enter (or select) the offline validation file you want to create 

[NOTE: Be certain not to overwrite your personal local file]. 

6. Enter your selection criteria. Leave a "??" in all fields you do 

NOT want to be downloaded to the off-line validation file. A 

blank in the selection criteria will select all values, or you can 

limit the selection based on specific criteria. 

7. Execute the program. 
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Premium Only – Default User Settings 
 

Premium Users can set default values for all "Balancing Account Info" values, "Maximum Input Lines 

per Document," and "No Data Character". This is extremely useful for large implementations where 

the number of GLSU users may be in the hundreds or thousands of users and you do not want the 

end users to have to set these values manually one user at a time. 

 

In order to set these values, one Premium user will change their values to the appropriate values and 

then simply select the "Save Defaults for All Users" button. 

 

NOTE: All existing GLSU user settings which DO NOT ALREADY HAVE A VALUE SAVED FOR THAT FIELD 

will be overwritten with the Premium user’s settings and values. All newly registered GLSU users' 

settings registered after the Premium user performs this action will also be created with these default 

settings. 

 

If a mistake is made, the Premium user can reset to factory default settings by selecting the "Reset 

for All Users" button. This will remove ALL settings which were created by this feature AND custom 

settings which were created by end users. Please be cautious when using the "Reset for All Users" 

function. This functionality does NOT create settings for SAP IDs which are not registered GLSU users. 
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Troubleshooting 

 

Getting Help from your Premium Users 

Standard Users should raise all first level support issues with their Premium Users per the Software 

License Agreement signed by your principals. If there is an issue which requires additional support, 

the Premium user may always open a support ticket, but all resolutions and communication must be 

performed through a Premium user. This helps us keep your maintenance costs below industry 

averages. 

 

To see who your Premium users are click on "Show My Contacts". 

 

 
 

Using the Support Portal 

 

GLSU uses a web-based support portal which allows our users to notify us if there are questions or 

problems with the software that need to be resolved. 

 
Premium Users at your company are eligible to receive Support Portal login IDs. If they have not 

already done so, each Premium user should request one. 

The support portal and ID request from is accessible from https://www.magnitude.com/support 

 

Once your ID has been confirmed (you will receive an email), you may login to the support portal 

system on the same support page by clicking "Log in to the Portal". 

https://www.magnitude.com/support
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Export a Document (2-Step Posting Process) 

 

You may choose to post your document to SAP using a batch posting method. The batch posting 

method exports an uploadable file onto your PC. Many times this will be used to troubleshoot an 

issue and may be requested by Support. 

From the GLSU menu... 

1. Choose menu item "Export". 

2. Select "Copy Filename to Clipboard". 

3. Login to SAP via the SAP GUI (if you are not already logged in). 

4. Execute transaction ZGLSU. 

5. Paste (Ctrl-V) the filename from Step 2 into the "PC Spreadsheet Output File" field. 

6. Press the green Execute (F8) button. 

 

NOTE: The file is saved under the same name as your spreadsheet, with a .ZGL extension. 

 

See Processing "Export" Files for more detailed information (with screen shots) about manually 

processing the files in SAP. 

 

 

Custom Pick Lists 

For custom fields like ZZnnnnnn, ex. ZZCHAN – Distribution Channel, there is normally no pick list 

available. However, one can be created with a little help from an ABAP programmer. All of the 

ZZnnnnnn fields are candidates for custom field pick lists. 

 

 
 

Have your ABAP resource look at the examples available in SAP function 

/ZOPTION/GLSU_LIVE_CUSTPICK. There is an example for returning a custom ZZCHAN pick list that 

they can used as-is or use as a template to build custom pick lists as needed. 
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"Scripting Not Enabled" Error Message 

Occasionally within a GLSU workbook, a user will see a pop-up error message titled "Scripting Not 

Enabled", which gives instructions for enabling a scripting setting through SAP GUI. 

 

However, it may be confusing because when the user looks at their SAP GUI settings, the checkbox 

for "Enable Scripting" appears to be already checked! 

 

The GLSU error message is correct: 

Occasionally when it is installed, a bug in SAP GUI causes the checkbox for "Enable Scripting" to say 

it is already checked, but the programmatic value for that control is NOT actually set. 

 

The solution is very simple! 

Inside the SAP GUI Logon pad: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
1. Turn OFF scripting by removing the tick mark from the checkbox. 

2. Click the Apply button or the OK button to save the change. 

3. Then turn scripting ON by ticking the checkbox for "Enable Scripting". 

4. Click OK to save and exit SAP GUI Options. 
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Once this setting is saved, this only needs to be done ONE time per user. 
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Problems with the Toolbar? 

GLSU PC files: As of GLSU 6.2, there is only one file that needs to be 

installed in the Excel add-in screen. 

 

"Z Option Glsu" = GLSU functions [filename: Z Option GLSU.xlam] 
 

To check to see if GLSU is installed, go to Excel's File → Options → Add-Ins screen. 

 

 
 

The error conditions below generally occur when only part of GLSU is installed/active on the user's 

PC. Such issues can usually be corrected by manually activating an add-in (which task does not 

usually need admin rights), or by re-running SetupGLSU.EXE (with full PC administrator rights). 

 

To Manually Install an Add-In: Do the following in Excel... 

1. Go to Excel File → Options → Addins (select it on the left of the screen). 

2. At the bottom of the Add-ins screen, select "Manage:" → Excel Add-Ins → click "Go...", which will 

pop up a small "Add-Ins" screen with checkboxes. 

3. Click the "Browse" button, which opens a file explorer window. 

4. Navigate to directory "C:\Program Files (x86)\Z Option\GLSU\" and select 

"Z Option GLSU.xlam" and click OK until you get back to Excel. 

5. Then close Excel and re-open Excel and it should be active. 

 

 

If the GLSU tab is still not visible and active in Excel, GLSU may not have been installed using “Run as 

administrator”. This is required so that the setup program can create required registry entries vital for 

GLSU to operate properly. 

Running SetupGLSU.EXE with full PC administrator rights adds these keys to the Registry   

automatically. If re-running the installer with full admin rights is not possible, and manually adding the 
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add-in using the steps above still doesn't work, then there is likely a policy or restriction preventing 

the required Registry entries from being created. 
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Technical Installation 
 

There are 4 main steps that must be completed for GLSU to run on your productive SAP system, plus 

an optional 5th step. 

 

1. Install the transport and import it into SAP. 

2. Set up the logical filenames for your system. 

3. Set up user authorization. 

4. Transport all of the above to any systems where GLSU will be run. 

5. Optional – Set profile parameter. 

Each of the steps are detailed below. 

 

UPGRADE NOTE: 

IF YOU ARE UPGRADING FROM A PRIOR VERSION, you probably have already set up the logical 

filenames and authorization. Those steps can be skipped for upgrades. 

 

 
************************************************************ 

SECTION 1 - INSTALL AND IMPORT THE GLSU TRANSPORT 
************************************************************ 

 

1.1 Copy the all the files from the CD root directory (or .ZIP file) into \usr\sap\trans (or its equivalent) 

on your SAP machine. 

 

1.2 Run the included ZOPUNSAR.BAT file (if you are on a Windows NT operating system). This will 

expand the compressed file ZOPGLSU60.SAR. If you are not on Windows NT, run the sapcar 

commands manually, e.g., "sapcar –xvf ZOPGLSU61a.SAR". 

 

NOTE: This version is Unicode compliant. Even if your SAP system is not Unicode, you should still install 

this version. The code is Unicode compatible and it will save you an upgrade step if you 

should ever convert your SAP system to Unicode. 

 

Example: 

 

e:\usr\sap\trans>zopunsar 

 

sapcar -xvf ZOPGLSU60.SAR 

x cofiles/K900077.ZD2 

x cofiles/K900077.ZD2 

 

NOTE: Actual transport numbers may vary from GLSU version to GLSU version. 

 

The transport for this release is as follows: 

ZD2K900077 – GLSU MAIN PROGRAM 
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1.3 3 Add the transport to the correct import queue. Use transaction STMS. Press the "Truck" 

icon or Overview → Imports. 
 

Double-click the queue for the system into which you want to import the transport (usually 

your development box). 
 

When the Import Queue is displayed, select Extras → Other Requests → Add and enter the 

transport number (e.g. ZD2K900077). Confirm that you wish to add it to the queue. 
 

1.4 Import the transport using Request → Import. 

 

If errors occur, try re-importing the file using more override flags. 

Some errors in importing are unavoidable. 

 

If something fails to generate, try importing it again, and then try manually generating the 

object. 

 

 
************************************************************ 

SECTION 2 - SET UP LOGICAL FILE NAMES 
************************************************************ 

 

 

IF YOU ARE UPGRADING FROM A PRIOR VERSION, you probably already have the logical filenames 

set up – those have not changed in the upgrade. 

 

If you are in a technical environment that has more than one application server, please read the 

"Supported Technical Environment Notes" section below before starting this step for important 

information. 

 

2.1 Determine what path you would like to use to store the GLSU temporary posting files. 

 

These files are usually less than 2-3 megabytes in size, but for some heavy users, they can 

approach 15 megabytes. The files are deleted as soon as the process completes, so the 

normal state of this directory is to be empty. During rare circumstances, files can get hung; it 

is good practice to occasionally purge any files over 30 days old. 

 

You will need to set up a logical file names and logical file paths for each SAP system ID 

where GLSU will be run. The logical file names are in the format "ZOPTION_GLSU_POST_xxx" 

where "xxx" is replaced by the system ID. "ZOPTION_GLSU_POST_ZD1" is provided in the 

transport only as an example. 

 

2.2 Use transaction FILE to create the logical file paths. 

 
Acknowledge the client-independent warning. Scroll to the bottom of the list of logical 

paths. Select ZOPTION_GLSU_POST_ZD1 and press the Copy As... button or use menu option 

Edit → Copy As... This will allow you to create a new entry and shows you the current 

ZOPTION_GLSU_POST_ZD1 as the default name. Erase the "ZD1" and put in your system ID. 

When you have it correct, press Enter, and when asked if you want to copy dependent 

entries, select Copy All. 

UPGRADE NOTE: 
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You now need to set the path for this new logical file path definition. Select the new 

ZOPTION_GLSU_POST_xxx entry and press the second file folder icon up at the top. This allows 

you to enter the physical file name for Windows NT. If you are not using Windows NT, please 

use the New Entries button and enter your correct operating system in the Syntax Group  

field, along with the correct physical path for this system ID. 

 

If you want to set up more than one system ID, go back to the main "Change View Logical 

File Paths Overview" screen and press the top file folder icon. Do the Copy As... and repeat 

the instructions in Section 2.2. 

 
When you are finished creating the logical file paths, press the SAVE button, or choose menu 
option Table View → Save.  It will ask for a transport number - create a new one so you can 

easily track the logical file names. 

 

2.3 Use transaction FILE to create logical file names. 

 
Now that all the logical file paths have been defined and their physical paths defined, we 
need to assign logical file names that use those paths. While still in transaction FILE, click on 
the 3rd file folder icon. Scroll to the bottom of the list, and again, we will select the entry 
called ZOPTION_GLSU_POST_ZD1 and press the Copy As... button or use the menu option  
Edit → Copy As... This will pop up a screen requesting the logical file information. The only 

thing that needs to be changed is the logical file and logical path, replacing "ZD1" with your 

desired system id in both fields. 

 

NOTE: If you want to also change the physical file name, you may edit the "Physical file" field. 

The text "<PARAM_1>" is replaced by the system with Username+Timestamp, so for John Smith, 

whose USERID is JSMITH, running the program at 8:38 in the morning would have a filename like 

ZOP_GLSU_JSMITH083079 in the path you defined in step 2.2. 

 

Repeat 2.3 as necessary for all your system IDs. 

 

When you have finished creating the logical file names, press the SAVE button, or choose the menu 

item Table View → Save. 

 

As an alternative configuration method, you can choose to create one logical filename definition 

as ZOPTION_GLSU_POST and transport it throughout your landscape. It is important to                

note you must use extreme care when utilizing this method. Use appropriate variables as this path 

will be used in all systems including production unless you choose to maintain the entries 

separately in each system. In the case of a mixed logical filename configuration (one that 

contains both a ZOPTION_GLSU_POST_SID entry and a ZOPTION_GLSU_POST entry), the "SID" entry 

will be used if one is available and then the entry without a SID. 

 

2.4 Record the transport number. 

 

This package will have to be transported to all systems where GLSU will be run. 
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************************************************************ 

SECTION 3 - SET UP USER AUTHORIZATIONS 
************************************************************ 

UPGRADE NOTE : 

IF YOU ARE UPGRADING FROM A PRIOR VERSION, most of the prior authorizations will still work – the 

only addition is RFC access if you want your users to be able to post their documents directly from 

the Excel spreadsheet via RFC connection. 

 

 

3.1 The following is a list of authority objects which are needed to use the GLSU solution. 

 

Authorization 

Object 

 

Field :: Values 

S_TCODE Transaction code :: 

"FB01" for document posting 

"SM35" for document processing/log viewing 

"ZGLSU" for the main GLSU program 

"FBS1" for Accrual 

"FBV1", "FBV0", and "FBVB" for Park Document 

"FBB1" for Post Foreign Currency Adjustment 

"FV50L" for Park to Ledger Group 

S_BTCH_JOB JobAction :: RELE 

JobGroup :: * 

S_BDC_MONI Batch input monitoring activity :: DELE 

Session name :: FI-GLSU* 

S_RFC Activity :: 16 

Name of RFC to be protected :: /ZOPTION/GLSU, /ZOPTION/COMMON, 

RFC1, SRFC, SUSO, SYST, RFCH, BDS_BAPI (for attaching 

documents), 0002 (for document drillback), SDIFRUNTIME (for meta- 

data retrieval) 

Type of RFC object to be protected :: FUGR 

S_PATH Full Authorization 

S_DATASET Activity: Full Authorization (Delete authority is needed to cleanup 

temporary intermediate files) 

Filename: Path as configured in Section 2 

Program: "/ZOPTION/*", "RFBIBL0*" 

F_BKPF_BUK Company Code: All required Activity: 

"01" for Posting and Accrual 

"03" to download master data in the .INI or real-time pick lists and 

description functionality. This is also the activity which was added to 

adhere to SOX requirements for data access 

"77" for Park Document 

S_GUI For uploading/downloading files: 

"60" and "61" for ACTVT (Activity) 
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Authorization 

Object 

 

Field :: Values 

S_SCR Authorization for SAP GUI scripting: 

"16" for ACTVT (Activity) 

S_BDS_DS For attaching documents to the BDS: 

"BKPF" and "ACCTGDOCMT" for ClassName 

"BO" (Bravo, Oscar) for ClassType 

"01" - "05", and "30" for ACTVT (Activity)  Additional activities as 

required. 

S_BDS_D For attaching documents to the BDS: 

"01" - "05", and "30" for ACTVT (Activity)  Additional activities as 

required. 

"BDS*" for LOIO_CLASS (or as configured) 

 

 

 

 
************************************************************ 

SECTION 4 - TRANSPORT TO OTHER SYSTEMS 
************************************************************ 

 

4.1 Transport all of the above to any systems where GLSU will be run. 

 

 
************************************************************ 

SECTION 5 – OPTIONAL – SET PROFILE PARAMETER 
************************************************************ 

 

5.1 If users require document drill-back functionality from Excel, set system profile parameter 

"sapgui/user_scripting" equal to "TRUE". 

 

Supported Technical Environment Notes: 

When configuring logical file paths, it is important that the file paths specified are either 

Network File System or Windows Shares, common and writable across all application servers 

(if the environment has more than one application server). Since GLSU jobs are load- 

balanced, it is possible that jobs will be started on application servers other than the one the 

user has logged onto. 

 

BDC Log files stored at the application server OS level must be configured to be read by all 

application servers. The default path suggested by SAP is \usr\sap\<SID>\SYS\global. If 

this directory is not common to all application servers, the financial document number may 

not be retrievable by the GLSU application since the document number is retrieved from 

these files. 

 

SAP Upgrade Notes: 

If you are upgrading your SAP system from any 4.0x, 4.5x, 4.6x, or 4.7x version to any of these 

versions, you do not need a separate transport. Although there are significant differences in 

the SAP repository components for these SAP versions, ALL of the objects necessary to run in 

each of these environments are delivered with the one codebase. Therefore, an upgrade of 



  page 154 

 

 

the Z Option software is not necessary unless you desire new functionality in a later release of 

GLSU. 

 

 

 

 

 
 

 

Object Directory LIMU ADIR R3TRSOTR/ZOPTION/GLSU 

Table Definition LIMU TABD /ZOPTION/GLSU_TEMPLATE_DATA 

Table Definition LIMU TABD /ZOPTION/GLSU_TEMPLATE_LIST 

Class (ABAP Objects)  R3TR CLAS /ZOPTION/CL_IM_GLSU_PRKLDG 

Domain R3TR DOMA /ZOPTION/CHAR260 
Domain R3TR DOMA /ZOPTION/CHAR8000 

Data Element R3TR DTEL /ZOPTION/MAXROWS 

Data Element R3TR DTEL /ZOPTION/ROWNUMBER 

Data Element R3TR DTEL /ZOPTION/SHEETNUMBER 

Data Element R3TR DTEL /ZOPTION/SPLITNUMBER 

Data Element R3TR  DTEL   /ZOPTION/VAL260 

Data Element R3TR  DTEL   /ZOPTION/VALKEY 

Data Element R3TR  DTEL  /ZOPTION/VALLINE 

Data Element R3TR     DTEL     /ZOPTION/VALMSG 

Data Element R3TR DTEL /ZOPTION/DB_FILTER_NAME 

Data Element R3TR DTEL /ZOPTION/DB_FILTER_VALUE 

Enhancement Implementation R3TR ENHO /ZOPTION/GLSU_PRKLDG_EXT 

Enhancement Implementation R3TR ENHO /ZOPTION/GLSU_PRKLDG_IMP 

Function Group R3TR     FUGR   /ZOPTION/COMMON  Contains: 

/ZOPTION/PING 

/ZOPTION/GET_PREMIUM_USERS 

/ZOPTION/USER 

Function Group R3TR FUGR   /ZOPTION/GLSU Contains: 

/ZOPTION/GLSU_POST 

/ZOPTION/GLSU_GET_VALIDATION 

/ZOPTION/GLSU_LIVE_PICK_GET 

/ZOPTION/GLSU_LIVE_VAL_GET 

/ZOPTION/GLSU_LIVE_AUTH 

/ZOPTION/GLSU_LIVE_DESCR_GET 

/ZOPTION/GLSU_LIVE_CUSTVAL 

/ZOPTION/GLSU_GET_AUFNR 

/ZOPTION/GLSU_INSTALL_CHECK 

/ZOPTION/GLSU_LIVE_SUBST 

/ZOPTION/GLSU_LIVE_SETTING_GET 

/ZOPTION/GLSU_LIVE_COBL_CHECK 

/ZOPTION/GLSU_LIVE_CUSTEXTRACT 

/ZOPTION/GLSU_LIVE_CUSTPICK 

/ZOPTION/GLSU_LIVE_DOCEXTRACT 

/ZOPTION/GLSU_PARK_LDGRP 

/ZOPTION/GLSU_RWBAPI_COBL 

/ZOPTION/GLSU_GET_TEMPLATE_LST 

/ZOPTION/GLSU_GET_TEMPLATE_DAT 

Transport object list for GLSU: 
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/ZOPTION/GLSU_LINK_ATTACHMENT 

/ZOPTION/GLSU_LIVE_FB00_GET 

/ZOPTION/GLSU_VALIDATE_BALACCT 

/ZOPTION/GLSU_GET_DASHBRD_DATA 

Message Class R3TR MSAG  /ZOPTION/GLSU 

Program R3TR PROG  /ZOPTION/GLSU 

Program R3TR PROG  /ZOPTION/GLSU_PRINT_HISTORY 

Program R3TR PROG  /ZOPTION/GLSU_SEND_CONFIG 

Program R3TR PROG  /ZOPTION/GLSU_SEND_CONFIG_OFFL 

Program R3TR PROG  /ZOPTION/GLSU_TOP_CONSTANTS 

Program R3TR PROG  /ZOPTION/GLSU_TOP_TABLES 

Program R3TR PROG  /ZOPTION/HIDDEN 

Business Add-Ins - Implementations R3TR SXCI /ZOPTION/GLSU_PRKLDG 
 

Table 

Table 

Table 

Table 

Table 

Table 

Table 

Table 

Table 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

TABL 

TABL 

TABL 

TABL 

TABL 

TABL 

TABL 

TABL 

TABL 

/ZOPTION/CUSTMSG 

/ZOPTION/FIELD_COLUMNS 

/ZOPTION/GLSU_PARK_LDGRP_COMM 

/ZOPTION/LIVEDES 

/ZOPTION/LIVERET 

/ZOPTION/LV_IN 

/ZOPTION/LV_OUT 

/ZOPTION/MSG_LOG_TX 

/ZOPTION/PICKLIST 

Table 

Table 

Table 

Table 

Table 

Table 

Table 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

R3TR 

TABL 

TABL 

TABL 

TABL 

TABL 

TABL 

TABL 

/ZOPTION/VAL 

/ZOPTION/ZBAPIRETURN1 

/ZOPTION/ZBSEG 

/ZOPTION/ZDATA 

/ZOPTION/ZLOG 

/ZOPTION/DASHBOARD_EXTRACT 

/ZOPTION/DASHBOARD_FILTER 

Transaction R3TR TRAN /ZOPTION/GLSU 

Transaction R3TR TRAN ZGLSU 

Table Type R3TR TTYP /ZOPTION/T_BBSEG 

View Maintenance: Data R3TR VDAT   V_FILENACI 

View Maintenance: Data R3TR VDAT   V_FILEPATH 

View Maintenance: Data R3TR VDAT   V_PATH 

Package R3TR DEVC  /ZOPTION/COMMON 

Package R3TR DEVC  /ZOPTION/GLSU 

Package R3TR DEVC  ZGL1 


